


 Bootstrap 3 is designed to be responsive to 
mobile devices. 

 Mobile-first styles are part of the core 
framework of Bootstrap.You have to add the 
following <meta> tag inside the <head> 
element for proper rendering and touch 
zooming: 

 <meta name="viewport" content="width=de
vice-width, initial-scale=1">   

 Note: The "width=device-width" part is used to 
set the width of the page to follow the screen-
width of the device (vary according to the 
devices). 

 



container is used to wrap the site contents. 
There are two container classes. 

 The .container class provides a responsive 
fixed width container. 

 The .container-fluid class provides a full 
width container, spanning the entire width 
of the viewport. 

<div class="container">   

  <h1> First Bootstrap web page</h1>   

  <p>Write your text here..</p>    

</div>   

 

 



The Bootstrap Grid System allows up to 12 

columns across the page. You can use all 12 

columns individually or you can groups the 

columns together to create wider columns. 

 

 

 

 

Bootstrap Grid System is responsive and the 

columns are re-arranged automatically 

according to the screen size. 

 



There are four classes in Bootstrap Grid System: 

 xs (for phones) 

 sm (for tablets) 

 md (for desktops) 

 lg (for larger desktops) 

 



 <div class="container-fluid">   

   <h1>Unequal Columns</h1>   

   <p>Resize the browser window to see the effect.</p
>   

   <p>The columns will automatically stack on top of e
ach other when the screen is less than 576px wide.</
p>   

   <div class="row">   

     <div class="col-sm-4" style="background-
color:lavender;">.col-sm-4</div>   

     <div class="col-sm-8" style="background-
color:lavenderblush;">.col-sm-8</div>   

   </div>   

 </div>   
 



 Bootstrap Basic Table 

A basic Bootstrap table has a light 
padding and only horizontal dividers. 

The .table class adds basic styling to a 
table 

 Striped Rows 

The .table-striped class adds zebra-stripes 
to a table 

 Bordered Table 

The .table-bordered class adds borders 
on all sides of the table and cells: 

 

 



 Hover Rows 

The .table-hover class adds a hover effect 

(grey background color) on table rows 

Bootstrap 4 Contextual Table 

Contextual classes can be used to color 

the whole table (<table>), the table rows 

(<tr>) or table cells (<td>). 

The classes that can be used are: 

.table-primary, .table-success, .table-info, 

.table-warning, .table-danger, .table-

active, .table-secondary, .table-light and 

.table-dark: FOR EXAMPLE 

 

https://www.w3schools.com/bootstrap/tryit.asp?filename=trybs_table_contextual&stacked=h


There are seven styles to add a button in 
Bootstrap. Use the following classes to 
achieve the different button styles: 

 .btn-default 

 .btn-primary 

 .btn-success 

 .btn-info 

 .btn-warning 

 .btn-danger 

 .btn-link 

       For Example 

 

https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapbutton1
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapbutton1
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapbutton1
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapbutton1
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapbutton1
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapbutton1
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapbutton1
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapbutton1


In Bootstrap, you can choose a button 

according to your requirement. It provides 

four button sizes.The following classes 

define the different sizes: 

 .btn-lg 

 .btn-md 

 .btn-sm 

 .btn-xs 

       For Example 

 

https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapbutton2
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapbutton2
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapbutton2
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapbutton2
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapbutton2
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapbutton2
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapbutton2
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapbutton2


Bootstrap Image Shapes 

 Rounded Corners: 

 Circle:      

 Thumbnail:    

 

 

 

 

 

 

 



Example 

 rounded  

<img src="cinqueterre.jpg" class="img-

rounded" alt="Cinque Terre"> 

 Circle 

<img src="cinqueterre.jpg" class="img-

circle" alt="Cinque Terre"> 

 Thumbnail 

<img src="cinqueterre.jpg" class="img-

thumbnail" alt="Cinque Terre"> 

 



 A jumbotron indicates a big box for 

calling extra attention to some special 

content or information. 

 A jumbotron is displayed as a grey box 

with rounded corners. It also enlarges the 

font sizes of the text inside it. 

 Jumbotron Inside Container 

Place the jumbotron inside the <div 

class="container"> if you want the 

jumbotron to NOT extend to the edge of 

the screen:     For Example 

 

https://www.w3schools.com/bootstrap/tryit.asp?filename=trybs_jumbotron&stacked=h


Typography provides some utilities to add additional 
styles to texts.These utilities are: 

 Text alignment 

 Text transform 

 Font weight and italics 

TEXT ALIGNMENT 
 Align text left: 

 <p class="text-left">Left aligned text.</p>   
 Align text center: 

 <p class="text-center">Center aligned text.</p>   

 Align text right: 

 <p class="text-right">Right aligned text.</p>   
 Align text justify: 

 <p class="text-justify">Justified text.</p>   

 Align text no-wrap: 

 <p class="text-nowrap">No wrap text.</p>   

 



You can align text on viewports according to 

their size also. 
 Left aligned text on viewports sized SM (small) or wider. 

 <p class="text-sm-left">Left aligned text on viewports sized SM (small) or wider.</p>   

 Left aligned text on viewports sized MD (medium) or wider. 

 <p class="text-md-

left">Left aligned text on viewports sized MD (medium) or wider.</p>   

     

 Left aligned text on viewports sized LG (large) or wider. 

 <p class="text-lg-left">Left aligned text on viewports sized LG (large) or wider.</p>   

 Left aligned text on viewports sized XL (extra-large) or wider. 

 <p class="text-xl-left">Left aligned text on viewports sized XL (extra-

large) or wider.</p> 

  
 



 For lowercase text: 
Use "text-lowercase" class to make the text appear in lowercase. 

<p class="text-lowercase">Lowercased text.</p>  

 For uppercase text: 
Use "text-uppercase" class to make the text appear in uppercase. 

<p class="text-uppercase">Uppercased text.</p>   

   For capitalized text: 
Use "text- capitalize" class to make the text's first letter appear in 

uppercase. 

<p class="text-capitalize">CapiTaliZed text.</p>   

 

 



It is used to quickly change the weight 

(boldness) of text or italicize text. 

 For bold text: 

<p class="font-weight-bold">Bold text.</p>   

 For Italic text:     

<p class="font-italic">Italic text.</p>   

 



Glyphicons are the icon fonts that are used in web projects. 

Bootstrap provides 260 Glyphicons from the Glyphicons Halflings set. 

 Some examples of Glyphicons are: 

 Envelope glyphicon 

 Print glyphicon 

 Search glyphicon 

 Download glyphicon etc. 

Glyphicons Syntax 

<span class="glyphicon glyphicon-name"></span>   

       For Example 

 

 

https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapglyphicon1
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapglyphicon1
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapglyphicon1
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapglyphicon1
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapglyphicon1
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapglyphicon1
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapglyphicon1
https://www.javatpoint.com/oprweb/test.jsp?filename=bootstrapglyphicon1


THANK YOU 







































































































Cloud Computing: An 

Introduction 

Cloud computing is the delivery of computing services over the internet. 

Learn about different types of clouds, advantages, challenges, 

implementation, security concerns, and the future of cloud computing. 

by GYANENDRA SHUKLA 

https://gamma.app


What is Cloud Computing? 

1 On-Demand Access 

Access to shared resources, 

like servers, storage, and 

databases, on-demand over 

the internet. 

2 Scalability & Flexibility 

Ability to scale resources up 

or down, depending on 

business needs, reducing 

costs and enabling rapid 

innovation. 

3 Pay-As-You-Go 

Usage-based pricing model, allowing businesses to pay only for the 

resources they use, rather than making large upfront investments. 

https://gamma.app


Types of Clouds 

Public Cloud 

Resources shared 

with multiple users. 

Private Cloud 

Resources dedicated 

to a single 

organization. 

Hybrid Cloud 

Combination of public 

and private cloud. 

Community 

Cloud 

Resources shared 

with specific 

community 

members. 

https://gamma.app


Advantages of Cloud Computing 

Cost Savings 

Eliminate the need for upfront 

investment in hardware and 

infrastructure maintenance 

costs. 

Scalability 

Scale resources up or down to 

match your business needs. 

Collaboration 

Enable collaboration and remote 

work across teams and 

locations. 

https://gamma.app


Challenges of Cloud Computing 

Data Security 

Protecting sensitive data in the 

cloud. 

Compliance 

Ensuring compliance with 

regulatory requirements. 

Vendor Lock-In 

Dependency on a specific 

cloud provider. 

https://gamma.app


Implementing Cloud Computing 

1 Assessment & Planning 

Evaluate existing IT infrastructure and 

plan migration to the cloud. 
2 Migration 

Transfer applications, data, and 

processes to the cloud. 3 Integration & Testing 

Integrate cloud services with existing 

systems and conduct thorough testing. 4 Deployment 

Launch and configure cloud services. 

https://gamma.app


Security Concerns 

1 Data Breaches 

Protecting data from 

unauthorized access and 

breaches. 

2 Identity and Access 

Management 

Ensuring proper 

authentication and 

authorization controls. 

3 Encryption 

Securing data in transit and at rest through encryption. 

https://gamma.app


Future of Cloud Computing 

Edge Computing 

Performing compute and 

data processing closer to 

the edge devices, reducing 

latency. 

AI & Machine Learning 

Leveraging cloud computing 

for advanced analytics and 

intelligent automation. 

Serverless Computing 

Building and running 

applications without the 

need to manage server 

infrastructure. 

https://gamma.app
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UNIT-1  
BASICS OF DATA COMMUNICATION 

• Introduction 

• Objectives  

• Concept of Communication System 

• Analog & Digital Communication 

• Data Communication Mode  

• Networking Protocol & Standards  

• Application of Computer Networking 



What is a Computer Network? 

• Computer Network is a group of computers connected with each other 

through wires, optical fibers or optical links so that various devices can 

interact with each other through a network. 

 

• The aim of the computer network is the sharing of resources among 

various devices. 

 

• A computer network is a set of devices connected through links. A node 

can be computer, printer, or any other device capable of sending or 

receiving the data. The links connecting the nodes are known as 

communication channels. 

 



Features Of Computer network 

 

A list Of Computer network features is given below. 

• Communication speed 

• File sharing 

• Back up and Roll back is easy 

• Software and Hardware sharing 

• Security 

• Scalability 

• Reliability 

 



Why Computer Networks  

 

 File Sharing 

 Hardware Resource sharing 

 Communication and collaboration 

 Organization 

 Remote access 

 Data protection 

 Internet & Intranet 

 



Introduction of Basics of                                

Data Communication  
• Data Communication is a process of exchanging data or 

information In case of computer networks this exchange is done 

between two devices over a transmission medium. 

 

• Data can be any text, image, audio, video, and multimedia files. 

Communication is an act of sending or receiving data. 

 

• Data communication refers to the exchange of data between a 

source and a receiver via form of transmission media such as a 

wire cable. Data communication is said to be local if 

communicating devices are in the same building or a similarly 

restricted geographical area. 

 

 



Objectives 

After going through this unit, you should be able to: 

• Know the concept of communication system 

• Understand the communication system and its components 

• Differentiate between analog and digital Communication 

• Know data communication modes 

• Differentiate between synchronous and asynchronous transmission 

• Differentiate among Simplex, half-duplex, full duplex communication 

• Understand the need of protocols and standard 

• Know the functions of OSI layers 

• Understand the concepts of encapsulation and End-to-end argument 

• Know the different protocol design issues 

• Know the applications of computer network 



CONCEPT OF COMMUNICATION 

SYSTEM 

Before we discuss about “communication system” and its components, let us understand 
“communication”. Can you define it, what definition will come first in your mind? When 
we asked some students, answers were like: 

 Delivery of message 

 Proper way of passing a signal to the intended user 

 Right message, to right person, at right time through right way.  

 

Some definitions of communication:  

 ” Communication is transfer of information from one person to another, whether or 
not it elicits confidence. But the information transferred must be understandable to 

the receiver – G.G. Brown 

 The imparting or exchanging of information by speaking, writing, or using some 

other medium.-Oxford Dictionary  



Components of Network Communications 

 Message  :  Data /Information to be communicates 

 Sender   :   Create and send messages 

 Receiver :  Receive the messages 

 Medium :  Which carry the message from sender to receiver 

 Protocol :  A set of rules that govern communications 

 



Networks – Distributed Processing 

Network is a set of devices or nodes connected by communication links. A 

node may be a computer, printer, scanner or any other electronic devices. In 

network work is to be distributed among all nodes instead of one single 

computer. It increase the system performances. A network must maintain 

certain criteria such as Performance, Reliability and Security 



Protocols & Standards 

In Computer Networks protocols and standards are very important. 

Protocol : A protocol is a set of rules that govern data communications. A 

protocol defines what is communicated, how it is communicated, and when it 

is communicated.   

The Key elements of the protocol are Syntax, Semantics & Timing 

Syntax : It refers Structure and format of the data that implies the order in 

which it will be presented. 

Semantics : It refers Section of bits how the particular pattern to be 

interpreted. 

Timing: It refers Transmission time  



Protocols & Standards 

Standards : Network has been standardized by number of regulatory body for 

different activities 

ISO – International Standard Organization 

ANSI – American National Standard Institute 

IEEE – Institute of Electrical and Electronics Engineers  

EIA – Electronic Industries Association 

 



Line Configuration 

1. Point to Point 

2. Multi -  Point 

As the link is dedicated the question of two devices transmitting at the 

same time does not arise and so no medium access control protocol 

needed. 

Figure : Point to Point Connection 



Two devices transmitting at the same time results in a collision. So Medium 

Access Control (MAC) protocols are required to avoid collisions and 

subsequent retransmissions. 

Figure : Multi - Point Connection 



ANALOG AND DIGITAL 

COMMUNICATION 
• Analog communication uses analog signals for the transmission of 

information. Digital communication uses digital signals for the transmission of 
information. Analog communication uses signals that can be represented by sine 
waves. Digital communication uses signals that can be represented by square 
waves. 

 

• A signal which is a continuous function of time and used to carry the information is 
known as an analog signal. An analog signal represents a quantity analogous to 
another quantity, for example, in case of an analog audio signal, the instantaneous 
value of signal voltage represents the pressure of the sound wave. 

 

• A signal that is discrete function of time, i.e. which is not a continuous signal, is 
known as a digital signal. The digital signals are represented in the binary form and 
consist of different values of voltage at discrete instants of time. 

 

• Basically, a digital signal represents the data and information as a sequence of 
separate values at any given time. The digital signal can only take on one of a finite 
number of values. 

 





Analog and digital signals are used to transmit information, usually through electric 

signals. In both these systems, the information, such as any text, audio or video, is 

transformed into electric signals. Let us see some of the differences between analog 

and digital systems below in table 1. 



Data Communication Modes 

• In this section, we will learn about some modes of data communication used in 

computer networking. Because we are going to study computer networking, we 

assume all data communication is digital. Digital communications is the physical 

transfer of data/bits over a communication channel. 

 

• As you may know, data are represented as an electromagnetic signal, such as an 

electrical voltage, radio-wave, microwave, or infrared signal. The channel or 

medium could be air (for wireless/mobile communication), copper wires, or 

optical-fibers. Remember, the data transmitted can be pure digital messages 

generated from a digital-data source, like a computer or a keyboard. 

 

• However, it may also be an analog signal such as a human voice over phone call, 

which could be digitalized 



Data Communication Modes 

• In this section, we will learn about some modes of data communication used in 

computer networking. Because we are going to study computer networking, we 

assume all data communication is digital. Digital communications is the physical 

transfer of data/bits over a communication channel. 

 

• As you may know, data are represented as an electromagnetic signal, such as an 

electrical voltage, radio-wave, microwave, or infrared signal. The channel or 

medium could be air (for wireless/mobile communication), copper wires, or 

optical-fibers. Remember, the data transmitted can be pure digital messages 

generated from a digital-data source, like a computer or a keyboard. 

 

• However, it may also be an analog signal such as a human voice over phone call, 

which could be digitalized 



Data Communication Modes  
Serial and parallel transmission 

• In digital communication, serial transmission 

of data refers to sequential transmission of bits, 

where a group of bits over a single channel 

represents a character. It requires less processing 

and fewer chances for error. The start and stop of 

a communication is specified by LSB (lowest 

significant bit) and MSB (most significant bit) as 

shown in the Figure. 

• Parallel transmission refers to simultaneous 

transmission of the bits over two or more 

separate channels. Here, we can transmit 

multiple bits simultaneously as given in Figure 

6, which allows for higher data transfer rates 

than that can be achieved with serial 

transmission. For example, for internal data 

communication in a computer system this 

method of parallel transmission is used. Parallel 

data transmission is less reliable for long 

distances because error correction is not very 

simple and economical in this case.  



Data Communication Modes 

 

 Synchronous and Asynchronous Transmission  

 

 Simplex, Half-Duplex, Full Duplex Communication  



 

Synchronous and Asynchronous Transmission  

 
• Synchronous transmission means both receiver and sender has an 

agreement (or aware) about timing for the sending data, so that both sender 

and receiver can coordinate (synchronize) their data signals. Asynchronous 

means "not synchronous", or no coordination between sender and receiver 

before transmission. Can you try to explore some examples of Synchronous 

and asynchronous communication that occurs in your day to day life 

 

• The asynchronous transmission uses start and stop bits to signify the 

beginning bit. For example, if sender wants to send some data "11100001”, 
it will be appended with the start and stop bit and look like "1 11100001 0". 

Where, we have assumed that ‘0’ is start bit and ‘1’ is stop bit. 
Asynchronous transmission works well where the characters are transferred 

at irregular intervals e.g. data entry from the keyboard. 



Synchronous and Asynchronous Transmission 

 
Asynchronous transmission has some advantages and disadvantages, like:   

 
• Each individual character is complete unit, hence if there is an error in a character, 

other sequence of characters are not affected. However, Error in start and stop bit(s) 

may cause serious problems in data transfer. 

 

• Doesn't require synchronization of both communication sides.  

 

• It is cost effective  

 

• The speed of transmission is limited.  

 

• Large relative overheads, a high proportion of the transmitted bits are uniquely used 

for control purposes 

 

 



Synchronous and Asynchronous Transmission 

 
Synchronous transmission has some advantages and disadvantages, like:   

 
• In comparison to asynchronous communication it has higher speeds, because the 

system has lesser possibility of error. But, if an error takes place, the complete set 

of data is lost instead of a single character.  

 

• Serial synchronous transmission is principally used for high-speed communication 

between computers but is unsuitable where the characters are transferred at 

irregular intervals. 

 

• It is gives lower overheads and thus, greater throughput. 

 

• Process is more complex 

 

• It is not very cost effective as hardware are more expensive  

 

 

 



Simplex, Half-Duplex, Full Duplex 

Communication 

The data transmission mode on the channel, can be classified 

into three ways simplex, half-duplex and full-duplex as 

given below 



Simplex Transmission  

Simplex transmission is one-way transmission. As the name 

implies, is simple in term of process and hardware. It is also 

called unidirectional because the signal travels in only one 

direction. For example, Radio or TV broadcasting system, 

which are always in one direction from Radio/TV station to 

our radio or TV sets.  



Half-Duplex Transmission  

In half-duplex transmission data transmission can be take place in 

both directions, but not at the same time. This means that only 

one side can transmit at a time. For example, walky-talky 

devices used by security agencies are half-duplex as only one 

person can talk at one time 



Full-Duplex Transmission  

Full-duplex (also known as Duplex) transmission can take place in 

both directions at the same time. For example, telephone or 

mobile conversation is an example of full-duplex 

communication, where both sender and receiver can hear 

each other at the same time. 



NETWORKING PROTOCOLS AND 

STANDARDS 

• Hardware Issues : At the hardware level, an additional component called 

router is used to connect physically distinct networks. A router connects to the 

network in the same way as any other computer. Any computer connected to the 

network has a Network Interface Card (NIC), which has the address (network 

id+ host id), hard coded into it. A router is a device with more than one NICs. 

Router can connect incompatible networks as it has the necessary hardware 

(NIC) and protocols.  

• Software Issues: The routers must agree about the way information would be 

transmitted to the destination computer on a different network, since the 

information is likely to travel through different routers, there must be a 

predefined standard to which routers must confirm. Packet formats and 

addressing mechanism used by the networks may differ. One approach could be 

to perform conversion and reconversion corresponding to different networks. 

But this approach is difficult and cumbersome. Therefore, the Internet 

communication follows one protocol suite, the TCP/IP.  

 

Problems in Computer Communication 



NETWORKING PROTOCOLS AND 

STANDARDS 

 Since it is difficult to deal with complex set of rules, and functions required for 

computer networking, these rules and functions are divided into logical groups 

called layers. Each layer can be implemented interdependently with an interface 

to other layers providing with services to it or taking its services like data, 

connection and error control functions are grouped together and make a layer. 

A. Speech in telephone conversation is translated, with electrical segments and 

vice-versa. Similarly in computer system the data or pattern are converted into 

signals before transmitting and receiving. These function and rules are grouped 

together and form a layer.  

Layering 



OSI Model 

International Standard Organization (ISO), established in 1947, is a 

multinational body dedicated to worldwide agreement on International 

Standards.  ISO standards cover all aspects of network communications is 

the Open System Interconnection (OSI) Model.  

 

It consists of Seven separate but related layers, each of which defines a 

segment of process of moving information across of network. 

 

Features : 

 Regardless of underlying network architecture 

 Not Vendor Specific 

 OSI is not a protocol – A model 



Layered Hierarchy  



OSI Layers Function 

Lower Layers : Layer 1, 2, 3 are the network support layers, they deal with the 

physical aspects of moving data from one device to another. 

 

Middle Layer : Layer 4 ensure end-to-end reliable data transmission 

 

Upper Layers : Layer 5, 6, 7 are working for user support. They allow 

interoperability among unrelated software system.  

 



Physical Layer 

It is the first layer of OSI Model. It coordinates the functions 

required to transmit a bit stream over the physical medium. 



Physical Layer 

Functions  

 Physical characteristics of interfaces and media 

 Representation of Bits 

 Transmission Rate 

 Line Configuration 

 Protocol 

 Transmission Media 



Data Link Layer 

It is the Second layer of OSI Model. It is responsible for Node-

to-Node delivery.  



Data Link Layer 



Data Link Layer 

Functions  

 

 Framing – Blocking of data into manageable data unit 

 Physical Addressing  - adding source and destination address 

 Flow Control – to avoid overwhelming  at receiver end 

 Error Control – retransmission of lost data 

 Access Control – unique identification of network devices 



Network Layer 

It is the Third layer of OSI Model. It is responsible for source to destination 

delivery of a packet possibly across multiple networks. It is mainly required to 

communicate between two different networks 



Network Layer 



Network Layer 



Network Layer 

Functions  

 

 Logical Addressing – Needed, if packet passes the network 

boundary  

 Routing – It defines routing path within internetwork 



Transport Layer 

It is the Forth layer of OSI Model. It is responsible for source-to-destination 

delivery of the entire message. It ensures that the whole message arrives 

intact and in order. 



Transport layer 

Internet 



Transport Layer 

Functions  

 

 Service-point addressing –  message sending  to Port Address   

 Segmentation & Reassembling – Divide into transmittable 

segments 

 Connection Control – connection oriented  / connectionless 

protocol 

 



Session Layer 

It is the Fifth layer of OSI Model. It establishes, maintains and synchronizes 

the interaction between communicating systems. 



Session Layer 

Functions  

 

 Dialog Controller –  It allows systems to enter into a dialog.  It 

defines Half / Full duplex communication     

 Synchronization – Adds checkpoints into a stream of data.  

 



Presentation Layer 

It is the Sixth layer of OSI Model. It is concerned with syntax and semantics of 

information exchanged between two systems  



Presentation Layer 

Functions  

 

 Translation – Changes information into bit stream       

 Encryption / Decryption – Encoded form for security 

 Compression – To reduce the number of bits to be transmitted 

 



Application Layer 

It is the Seventh layer of OSI Model. It enables user to access the network. 



Application Layer 

Functions  

 

 Network Virtual Terminal – Allow user to log on to a remote host       

 FTAM – File Transfer, Access and Management 

 Mail Service – E Mail Service 

 Directory Service – Global information access 

 



Summary of Layers Functions 



Encapsulation 

• Encapsulation is a technique of implementing layered architecture of a 

communication system. In OSI model we have separated all the 

communication functions/services into seven layers. We know that a layer 

serves the layer above it and is served by the layer below it, so to make it 

possible encapsulation techniques is followed for sending/receiving data 

between and through layers. In encapsulation we add some control 

information or “Header/Trailer” to a Data Unit by a communications 
protocol. This data along with header/trailer is known as Protocol Data Unit 

(PDU). This header/trailer actually creates an envelope for the PDU which 

has its address and addressee. 



Unit-2  

MODULATION AND ENCODING 



Introduction 



OBJECTIVES 

After going through this unit, you should be able to: 

 

 • Know the concept of modulation 

 

 • Understand the different Analog Modulation techniques 

  

• Differentiate between analog and digital modulation  
 

• Know process of analog to digital signal conversion 

 

 • Understand the sampling and quantization process 

 

 • Know the digital to analog signal conversion process  
 

• Understand the Digital Modulation techniques  



MODULATION 

 Often, the message being communicated is itself a signal, e.g., 

an audio signal, and to produce a signal that is suitable for 

transmission through the channel, we effect some 

transformation on the message signal. Modulation is the 

Process by which a property or a parameter of a signal is 

varied in proportion to another signal. The original signal is 

normally referred as the modulating signal and the high 

frequency signal, whose properties are changed, is referred as 

the carrier signal. The resulting signal is finally referred as the 

modulated signal. For example in case of the amplitude 

modulation, the amplitude of the carrier wave is varied in 

accordance with the amplitude of the message signal, whereas 

in the angle modulation, phase angle of the carrier is varied 

with respect to the message signal 

• .  



Benefits of Modulation 

1. Modulation can shift the frequency spectrum of a message signal into a 

band which is better suited to the channel. Antennas only efficiently 

radiate and admit signals, whose wavelength is similar to their physical 

aperture. Hence, to transmit and receive, say, voice, by radio we need to 

shift the voice signal to a much higher frequency band.  

 

1. 2. Modulation permits the use of multiplexing. Multiplexing means 

allowing simultaneous communication by multiple users on the same 

channel. For instance, the radio frequency spectrum must be shared and 

modulation allows users to separate themselves into bands. 3. Modulation 

can provide some control over noise and interference. For example the 

effect of noise can be controlled to a large extent by frequency 

modulation. 



AMPLITUDE MODULATION 

Amplitude modulation (AM) is a technique used in 

electronic communication, most commonly for 

transmitting information via a high frequency carrier 

wave. AM works by varying the strength of the 

transmitted signal in relation to the information being 

sent. For example, changes in signal strength may be 

used to specify the sounds to be reproduced by a load 

speaker, or the light intensity of television pixels. 

"Undulatory currents" are the initial implementations 

of the Amplitude modulation. These were the first 

method to successfully produce quality audio over 

telephone lines in 1870’s 



FREQUENCY MODULATION 

 Frequency modulation, FM is widely used for a variety of 

radio communications applications. FM broadcasts on the 

VHF bands still provide exceptionally high quality audio, and 

FM is also used for a variety of forms of two way radio 

communications, and it is especially useful for mobile radio 

communications, being used in taxis, and many other forms of 

vehicle. in view of its widespread use, frequency modulation, 

FM, is an important form of modulation, despite many forms 

of digital transmission being used these days. Since its first 

introduction the use of frequency modulation, FM has grown 

enormously. Now wideband FM is still regarded as a very high 

quality transmission medium for high quality broadcasting. 

FM, is also widely used for communications where it is 

resilient to variations in signal strength. 
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MULTIPLEXING AND SWITCHING 

• Introduction 

• Objectives 

• Multiplexing concept 
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• Space Division Multiplexing 
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• Message Switching 

• Circuit Switching 
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Introduction  
• The most fundamental need of any communication system design is to cater to large 

number of users. But this requires a large number of resources and large bandwidths 

supporting multiple channels. 

• Requirement for large number of resources can be met if the resources are available, but 

this makes it cost ineffective. 

• Therefore, the aim is always to use minimum number of resources and make their 

utilization to their fullest potential. Bandwidth always remains a critical resource due to 

its limited availability and therefore, communication systems try to harness its fullest 

potential. 

• Networks always require us to accommodate multiple signals utilizing a single piece of 

cabling to make it cost effective and reduce complexity. 

• This need is seen throughout networking whether we are talking about local area 

networks or wide area ones. Modern telephone systems must place a large number of 

calls over a limited amount of bandwidth (i.e. a trunk). Broadband LANs must have 

several different types of data on a single wire at once. 

• For these applications, we need to share the resources and in particular the bandwidth. 

Multiplexing and Switching are the two most important techniques being employed for 

this purpose in the present day communication systems and have been discussed in the 

present unit. 



OBJECTIVES 

• Know the concept of Multiplexing and Switching in computer networks 

 

• Understand the basic multiplexing techniques like FDM, TDM, CDM and 

SDM 

 

• Differentiate between different types of multiplexing techniques 

 

• Know the switching mechanisms 

 

• Differentiate between packet, circuit and message switching 

 

• Understand the different packet switching mechanisms 

After going through this unit, you should be able to: 



Multiplexing Concept 

• In general, a medium can carry only one signal at any moment in time. 

 

• For multiple signals to share one medium, the medium must somehow be divided, giving 

each signal a portion of the total bandwidth. Multiplexing (also known as MUXing) is a 

method by which multiple analog message signals or digital data streams are combined into 

one signal over a shared medium. 

 

• The basic aim of the Multiplexing is to share an expensive resource by putting-up multiple 

signals on the same channel. 

 

• For example, in telecommunications, several telephone calls may be carried using one wire 

 

• Multiplexing originated in telegraphy in the 1870s, and is now widely applied in different 

streams of communications. 

 

• When several communication channels are needed between the same two points, 

significant economies may be realized by sending all the messages on one transmission 

facility – called multiplexing. 

 



• In Figure 1, n number of signals from the low speed channels have been combined to 

one sigh speed link using a n:1 multiplexer. 

• Whereas the opposite process is carried out at the other end, where the signals are 

further separated into n number of low speed channels. This opposite process is 

referred as demultiplexing. 



• Multiplexing refers to the ability to transmit data coming from 

several pairs of equipment (transmitters and receivers) called 

low-speed channels on a single physical medium (called the 

high-speed channel). 

 

• Whereas, a multiplexer is the multiplexing device that 

combines the signals from the different transmitters and sends 

them over the high-speed channel. 

 

• A demultiplexer is the device which separates signal received 

from a high-speed channel into different signal and sends them 

to receivers. 



Four Basic Multiplexing Techniques: 

• Frequency division multiplexing (FDM) 

 

• Time division Multiplexing (TDM) 

 

• Code division Multiplexing (CDM) 

 

• Space-division Multiplexing (SDM) 

 

• Frequency division Multiplexing (FDM): Bandwidth is divided into different smaller frequency 

bands (range). 

 

• Time division Multiplexing (TDM):  Time slots are allocated to message signals in an non 

overlapping manner in the time domain so that individual messages can be recovered from time 

synchronized switches. 

 

• Quadrature Carrier/amplitude Multiplexing (QAM): Two message signals are transmitted in the same 

frequency band. The recovery is possible due to the carrier signals being orthogonal. 

 

• Code division Multiplexing (CDM) : Users occupy the same frequency band but modulate their 

messages with different codes TDMA FDMA CDMA when used for multiple access TDMA, FDMA, 

e.g., GSM, FM, AM, Wireless networks 



FREQUENCY-DIVISION MULTIPLEXING (FDM) 

• Frequency division multiplexing (FDM) is the technique used to divide the 

available bandwidth into a number of smaller independent logical channels with 

each channel having a small bandwidth. 

• FDM is an analog technique that can be applied when the bandwidth of a link is 

greater than the combined bandwidths of the signals to be transmitted.  

• The method of using a number of carrier frequencies each of which is modulated 

by an independent speech signal is in fact frequency division multiplexing. 



Frequency Division Multiplexing (FDM) 

FDM is an analog technique that can be applied when the bandwidth of a link 

is greater than the combined bandwidths of the signals to be transmitted.  



Frequency Division Multiplexing (FDM) 



Frequency Division Multiplexing (FDM) 



Frequency Division Multiplexing (FDM) 

 



Time Division Multiplexing (TDM) 

TDM is a digital process that can be applied when the data rate capacity of 

the transmission medium is grater than the data rate required by the sending 

and receiving devices. 



Time Division Multiplexing (TDM) 

TDM can be implemented in two ways: 

a) Synchronous TDM     

b) Asynchronous TDM 



Time Division Multiplexing (TDM) 

Synchronous TDM : It allocates exactly the same time slot to each device at all times, 

weather or not a device has anything to transmit.  



Time Division Multiplexing (TDM) 



Time Division Multiplexing (TDM) 

Asynchronous TDM : It allocates time slot to each device, weather a device 

has anything to transmit. It avoids wasted time. 





CODE DIVISION MULTIPLEXING 

• The concept of multiple access where we can allow several transmitters to send 

information simultaneously over a single communication channel and it allows 

several users to share a band of frequencies (or you can say bandwidth). 

 

• CDMA uses spread-spectrum technology and a special coding scheme (where each 

transmitter is assigned a code generally pseudorandom code) to allow multiple  

users to be multiplexed over the same physical channel. 

 

• By contrast, time division multiple access (TDMA) divides access by time, while 

frequency-division multiple access (FDMA) divides it by frequency. CDMA is a 

form of spread-spectrum signaling, since the modulated coded signal has a much 

higher data bandwidth than the data being communicated. 

 

• This allows more users to communicate on the same network at one time than if 

each user was allotted a specific frequency range. Remember that CDMA is a 

digital technology, so analog signals must be digitized before being transmitted on 

the network. 



SPACE DIVISION MULTIPLEXING 



SPACE DIVISION MULTIPLEXING 



SWITCHING 



SWITCHING 



SWITCHING 



Switching 

Switches are hardware and/or software devices capable of 

creating temporary connections between two or more devices 

linked to the switch but not to each other. 



Switching 
There are major three types of switching 

 



Circuit Switching 

 

 

Circuit switching creates a direct physical connection between two devices.  It 

is a device with n inputs and m outputs that creates a temporary connection 

between an input link and an output link.  

 



Circuit Switching 

 

 
Circuit switching has been categorized either of two technologies: 

a) Space-division Switching 

      In Space-division Switching, the paths in the circuit are separate from each 

other. It can be used for both analog and digital communication. 

b) Time-division Switching 

       In Time-division switching, uses time-division multiplexing to achieve 

switching.     

 



Packet Switching 

 

 

In Packet switch, data are transmitted in discrete units of potentially variable 

length blocks called packets. The maximum length of the packet is established 

by the network. 



Packet Switching 

 

 

There are two popular approaches to packet switching 

a) Datagram Approach 

      In this approach each packet is treated independent from all other. Even 

when one packet represents just a piece of a multi-packet transmission, the 

network treats it as through it existed  alone. Packets in this technology are 

referred to as datagram. 

 

b) Virtual Circuit Approach 

      In the virtual circuit approach to packet switching, the relationship between 

all packets belonging to a message or session is preserved. A single rout is 

chosen between sender and receiver at the beginning of the session.  

      It has been implemented in two formats:  

     a) Switched Virtual Circuit (SVC)  b) Permanent Virtual Circuit 

(PVC)  



Message Switching 

 

 

Message switching is best known by the descriptive term store and forward. In 

this mechanism, a node receives a message, stores it until the appropriate route 

is free, then sends it along. 
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Communication Mediums 

• Digital Data Transmission 

• Objectives 

• Serial and Parallel Transmission 

• Guided and Unguided Mediums 

• Twisted pair 

• UTP cable 

• STP Cable 

• Coaxial Cable  

• Fiber Optic Cables 

• Unguided Mediums  

• Connectors 

 

 



Digital Data Transmission 

 
• Data transmission, digital transmission, or digital communication is the 

transfer of data from one point to another or a point-to-point or point-to-

multipoint communication channel. 

 

• Data transmitted may be digital messages originating from a data source, 

such as a computer or a keyboard. 

 

• It may also be an analog signal, such as a phone call or a video signal. 

 

• Examples of such channels include copper wires, optical fibers, wireless 

communication channels, storage media and computer buses. 



Objectives  

• Know the concept of communication mediums 

 

• Differentiate between  Serial and Parallel Transmission  

 

• Differentiate Between Guided and Unguided Mediums  

 

• Know the features and limitations of different wired mediums  

 

• Understand the use of Twisted pair, Coaxial and Fiber Optical Cables  

 

• Know the functions of Unguided Mediums 

 

• Understand the use of different connectors 



SERIAL AND PARALLEL TRANSMISSION 

 In serial transmission, bits are sent sequentially on the same channel (wire). 

Serial transmission can be either synchronous or asynchronous. In 

synchronous transmission, groups of bits are combined into frames and 

frames are sent continuously with or without data to be transmitted. In 

asynchronous transmission, groups of bits are sent as independent units 

with start/stop flags and no data link synchronization, to allow for arbitrary 

size gaps between frames. However, start/stop bits maintain physical bit 

level synchronization once detected. 

SERIAL TRANSMISSION 



SERIAL AND PARALLEL TRANSMISSION 

  In parallel transmission, multiple bits (usually 8 bits or a byte/character) 

are sent simultaneously on different channels (wires, frequency channels) 

within the same cable as shown in Figure 1, or radio path, and 

synchronized to a clock. Parallel devices have a wider data bus than serial 

devices and can therefore, transfer data in words of one or more bytes at a 

time. 

PARALLEL TRANSMISSION 



Transmission Media 

A Transmission media can be broadly defined as which can carry data and 

information from one place to another. More specifically media may be free 

space, metallic cable or optical fiber. 

In telecommunication media can be divided into two categories 

a) Guided Media 

b) Unguided Media 

 



Transmission Media 



Guided Media 

The media which provide a conduit from one device to another. In the other 

sense we can say the transmission media which is covered in nature.  

Twisted- pair  Cable 

      One wire carries signal and the other one is used as a ground reference. The 

Receiver uses the difference. By twisting in one turn one wire is closer to 

the noise source and in the next turn the other wire is closer and the noise 

effect cancels out. Quality determined by number of twists per inch.  



Guided Media 

UTP Cable (Unshielded Twisted Pair) & STP Cable (Shielded Twisted Pair) 



Guided Media 

Coaxial cable carries signals of higher frequency ranges than those in twisted-

pair cable.  

 

Co-axial Cable 



Guided Media 

Fiber-Optic Cable : It is one of the good guided media for data transmission 

in the form of light. It is made of glass or plastic. 



Guided Media 



Guided Media 



Guided Media 



Transmission Impairment 

When the signal transmits through the medium from source to destination 

then source generated data cannot be reached to destination due to the 

imperfection of media. Causes are given below: 

Impairment  causes 

Attenuation Distortion Noise 



Network Performance 

Throughput : Throughput is the measure of how fast we can actually send 

data through the network.  

 

Latency (Delay): The latency defines how long it takes for an entire 

message to completely arrive at the destination from the time the first bit is 

sent out from the source.   

• Propagation Time 

• Transmission Time 

• Queuing Time 

• Processing Delay 



Thank You 





















































































































































































































































































































































































































































































































































  







 

 

 

 

 

 

 

 

PHP Operators can be categorized in following forms: 

 

• Arithmetic Operators 

•Assignment Operators 

•Bitwise Operators 

•Comparison Operators 

•Incrementing/Decrementing Operators 

•Logical Operators 

•String Operators 

•Array Operators 
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PHP comments can be used to describe any line of code so that other 

developer can understand the code easily. It can also be used to hide any 

code. 

 

PHP supports single line and multi line comments. These comments are 

similar to C/C++ and Perl style (Unix shell style) comments. 

 

•// (C++ style single line comment) 

 

•/**/Multiline comment 

 

 

 

 

 

 

















Process Management in OS 

 
A Program does nothing unless its instructions are executed by a CPU. A program in execution is called a 

process. In order to accomplish its task, process needs the computer resources. 

There may exist more than one process in the system which may require the same resource at the same time. 

Therefore, the operating system has to manage all the processes and the resources in a convenient and efficient 

way. 

 

Some resources may need to be executed by one process at one time to maintain the consistency otherwise the 

system can become inconsistent and deadlock may occur. 

 

The operating system is responsible for the following activities in connection with Process Management 

 

1.Scheduling processes and threads on the CPUs. 

2.Creating and deleting both user and system processes. 

3.Suspending and resuming processes. 

4.Providing mechanisms for process synchronization. 

5.Providing mechanisms for process communication. 



Attributes of a process 

The Attributes of the process are used by the Operating System to create the process control 

block (PCB) for each of them. This is also called context of the process. Attributes which are 

stored in the PCB are described below. 

 

1. Process ID 

When a process is created, a unique id is assigned to the process which is used for unique 

identification of the process in the system. 
 

2. Program counter 

A program counter stores the address of the last instruction of the process on which the process 

was suspended. The CPU uses this address when the execution of this process is resumed. 
 

3. Process State 

The Process, from its creation to the completion, goes through various states which are new, 

ready, running and waiting. We will discuss about them later in detail. 
 

4. Priority 

Every process has its own priority. The process with the highest priority among the processes 

gets the CPU first. This is also stored on the process control block. 
 

5. General Purpose Registers 

Every process has its own set of registers which are used to hold the data which is generated 

during the execution of the process. 
 

6. List of open files 

During the Execution, Every process uses some files which need to be present in the main 

memory. OS also maintains a list of open files in the PCB. 
 

7. List of open devices 

OS also maintain the list of all open devices which are used during the execution of the process. 



Process States 

The names of the states are not standardized although the process may be in one of the following states during execution. 

1. New:- A program which is going to be picked up by the OS into the main memory is called a new process. 
 

2. Ready:- Whenever a process is created, it directly enters in the ready state, in which, it waits for the CPU to be assigned. The OS picks the new 

processes from the secondary memory and put all of them in the main memory. 

The processes which are ready for the execution and reside in the main memory are called ready state processes. There can be many processes 

present in the ready state. 
 

3. Running:- One of the processes from the ready state will be chosen by the OS depending upon the scheduling algorithm. Hence, if we have 

only one CPU in our system, the number of running processes for a particular time will always be one. If we have n processors in the system then 

we can have n processes running simultaneously. 
 

4. Block or wait:- From the Running state, a process can make the transition to the block or wait state depending upon the scheduling algorithm or 

the intrinsic behavior of the process.When a process waits for a certain resource to be assigned or for the input from the user then the OS move 

this process to the block or wait state and assigns the CPU to the other processes. 
 

5. Completion or termination:- When a process finishes its execution, it comes in the termination state. All the context of the process (Process 

Control Block) will also be deleted the process will be terminated by the Operating system. 
 

6. Suspend ready:- A process in the ready state, which is moved to secondary memory from the main memory due to lack of the resources 

(mainly primary memory) is called in the suspend ready state. 

If the main memory is full and a higher priority process comes for the execution then the OS have to make the room for the process in the main 

memory by throwing the lower priority process out into the secondary memory. The suspend ready processes remain in the secondary memory 

until the main memory gets available. 
 

7. Suspend wait:- Instead of removing the process from the ready queue, it's better to remove the blocked process which is waiting for some 

resources in the main memory. Since it is already waiting for some resource to get available hence it is better if it waits in the secondary memory 

and make room for the higher priority process. These processes complete their execution once the main memory gets available and their wait is 

finished. 



State Diagram 

 

  



Process Scheduling in OS (Operating System) 

Operating system uses various schedulers for the process scheduling described below. 

 

1. Long term scheduler:- Long term scheduler is also known as job scheduler. It chooses the processes from the pool 

(secondary memory) and keeps them in the ready queue maintained in the primary memory. 

Long Term scheduler mainly controls the degree of Multiprogramming. The purpose of long term scheduler is to choose a 

perfect mix of IO bound and CPU bound processes among the jobs present in the pool. 

If the job scheduler chooses more IO bound processes then all of the jobs may reside in the blocked state all the time and the 

CPU will remain idle most of the time. This will reduce the degree of Multiprogramming. Therefore, the Job of long term 

scheduler is very critical and may affect the system for a very long time. 

 

2. Short term scheduler:-Short term scheduler is also known as CPU scheduler. It selects one of the Jobs from the ready queue 

and dispatch to the CPU for the execution. 

A scheduling algorithm is used to select which job is going to be dispatched for the execution. The Job of the short term 

scheduler can be very critical in the sense that if it selects job whose CPU burst time is very high then all the jobs after that, will 

have to wait in the ready queue for a very long time. 

This problem is called starvation which may arise if the short term scheduler makes some mistakes while selecting the job. 

 

3. Medium term scheduler:- Medium term scheduler takes care of the swapped out processes. If the running state processes 

needs some IO time for the completion then there is a need to change its state from running to waiting. 

Medium term scheduler is used for this purpose. It removes the process from the running state to make room for the other 

processes. Such processes are the swapped out processes and this procedure is called swapping. The medium term scheduler 

is responsible for suspending and resuming the processes. 

It reduces the degree of multiprogramming. The swapping is necessary to have a perfect mix of processes in the ready queue. 



Process Queues 
The Operating system manages various types of queues for each of the process 

states. The PCB related to the process is also stored in the queue of the same state. 

If the Process is moved from one state to another state then its PCB is also unlinked 

from the corresponding queue and added to the other state queue in which the 

transition is made. 

There are the following queues maintained by the Operating system. 

 

1. Job Queue 
In starting, all the processes get stored in the job queue. It is maintained in the 

secondary memory. The long term scheduler (Job scheduler) picks some of the jobs 

and put them in the primary memory. 

 

2. Ready Queue 
Ready queue is maintained in primary memory. The short term scheduler picks the 

job from the ready queue and dispatch to the CPU for the execution. 

 

3. Waiting Queue 
When the process needs some IO operation in order to complete its execution, OS 

changes the state of the process from running to waiting. The context (PCB) 

associated with the process gets stored on the waiting queue which will be used by 

the Processor when the process finishes the IO. 



Operation on Processes 

 
The operations of process carried out by an operating system are primarily of two types: 

1.      Process creation 

2.      Process termination 

1) Process Creation 

Process creation is a task of creating new processes. There are different situations in which a new process is created. There are 

different ways to create new process. A new process can be created at the time of initialization of operating system or when system calls 

such as fork () are initiated by other processes. The process, which creates a new process using system calls, is called parent 

process while the new process that is created is called child process. The child processes can create new processes using system calls. A 

new process can also create by an operating system based on the request received from the user. 

The process creation is very common in running computer system because corresponding to every task that is performed there is a 

process associated with it. For instance, a new process is created every time a user logs on to a computer system, an application 

program such a MS Word is initiated, or when a document printed. 

2) Process termination 

Process termination is an operation in which a process is terminated after the execution of its last instruction. This operation is used 

to terminate or end any process. When a process is terminated, the resources that were being utilized by the process are released by 

the operating system. When a child process terminates, it sends the status information back to the parent process before terminating. 

The child process can also be terminated by the parent process if the task performed by the child process is no longer needed. In 

addition, when a parent process terminates, it has to terminate the child process as well became a child process cannot run when its 

parent process has been terminated. 



The above figure shows the hierarchical structure of processes. 

The termination of a process when all its instruction has been executed successfully is called normal termination. However, there 

are instances when a process terminates due to some error. This termination is called as abnormal termination of a process. 
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Microsoft Word 

Microsoft Word is word processing software. It is developed by Microsoft and is part of Microsoft Office 
Suite. It enables you to create, edit and save professional documents like letters and reports. 

Brief History: 

Microsoft word was released in 1983 as Multi-Tool Word. Its first version was based on the framework of 
Bravo which was world's first graphical writing program. 

Microsoft renamed Multi Tool Word to Microsoft Word, and then in October 1983, Microsoft released its 
first version for the IBM PC. 

In 1985, Microsoft ported it to the Macintosh which was different from its DOS-based counterpart, i.e. 
Macintosh offered various major interface changes. 

In 1989, Microsoft released a new version of Word for its Windows operating systems. It was the 
Microsoft Word who introduced the concept of WYSIWYG (What You See Is What You Get), i.e. it allowed 
to create and display bold and italics text. 

In 2014, Microsoft developed the source code for Microsoft Word for Windows 1.1a. 

Microsoft Office Button 

Microsoft Office Button is located on the top left corner of the window. It is a new user interface feature 
that replaced the traditional "File" menu. You can also see this button in Outlook while creating a new 
message, task, contact, etc. 

See the image: 

 
When you click the button it offers a list of commands to perform different tasks which are New, Open, 
Save, Save As, Print, Prepare, Send, Publish and Close. These commands are described below the 
following image. 

 

See the image: 
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New: This command enables you create a new file, i.e. Word document. 

Open: This command allows you to open an existing file on the computer. 

Save: This command is used to save a file after completing the work. You can also save the changes made 
to the currently open file. 

Save As: This command helps you save a new file with a desired file name to a desired location on the 
hard drive. 

Print: This command is used to print a hard copy of the currently open document. 

Prepare: This command allows you to prepare the document for distribution, i.e. you can view and edit 
the document properties and inspect the hidden metadata. 

Send: This command allows you share the document with other users, i.e. you can send a document 
through e-mail or by posting to a blog. 

Publish: This command allows you distribute the document to other people, i.e. you can create a blog 
with the content of the document. 

Close: This command is used to close the currently open file. 
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Quick Access Toolbar 

Quick Access Toolbar lies next to the Microsoft Office Button. It is a customizable toolbar that comes with 
a set of independent commands. It gives you quick access to commonly used commands such as Save, 
Undo, Redo, etc. 

See the image: 

 
When you click the drop-down arrow next to toolbar it offers more commands. With a left click you can 
add any of these commands to Quick Access Toolbar. You can also remove the commands added to the 
tool bar. The indent, spacing values, individual styles and other features that appear on the ribbon cannot 
be added to quick access toolbar. The following image is showing the menu of quick access toolbar. 

See the image: 
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Title Bar 

It lies next to the Quick Access Toolbar. It displays the title of the currently open document or application. 
It is present on almost all windows displayed on your computer. So, if there are several windows across 
the screen, you can identify each window by looking at the title bar. In many graphical user interfaces, 
you can also move a window by dragging the title bar. 

See the image: 

 

Ribbon and Tabs 

The Ribbon is a user interface element which was introduced by Microsoft in Microsoft Office 2007. It is 
located below the Quick Access Toolbar and the Title Bar. It comprises seven tabs; Home, Insert, Page 
layout, References, Mailing, Review and View. Each tab has specific groups of related commands. It gives 
you quick access to the commonly used commands that you need to complete a task. 

See the image: 

 

Home tab: 

The Home tab is the default tab in Microsoft Word. It has five groups of related commands; Clipboard, 
Font, Paragraph, Styles and Editing. It helps you change document settings like font size, adding bullets, 
adjusting styles and many other common features. It also helps you to return to the home section of the 
document. 

See the image: 
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Insert tab: 

Insert Tab is the second tab in the Ribbon. As the name suggests, it is used to insert or add extra features 
in your document. It is commonly used to add tables, pictures, clip art, shapes, page number, etc. The 
Insert tab has seven groups of related commands; Pages, Tables, Illustrations, Links, Header & Footer, 
Text and Symbols. 

See the image: 

 

Page Layout tab: 

It is the third tab in the Ribbon. This tab allows you to control the look and feel of your document, i.e. you 
can change the page size, margins, line spacing, indentation, documentation orientation, etc. The Page 
Layout tab has five groups of related commands; Themes, Page Setup, Page Background, Paragraph and 
Arrange. 

See the image: 

 

References tab: 

It is the fourth tab in the Ribbon. It allows you to enter document sources, citations, bibliography 
commands, etc. It also offers commands to create a table of contents, an index, table of contents and 
table of authorities. The References tab has six groups of related commands; Table of Contents, 
Footnotes, Citations & Bibliography, Captions, Index and Table of Authorities. 

See the image: 
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Mailings tab: 

It is the fifth tab in the ribbon. It is the least-often used tab of all the tabs available in the Ribbon. It allows 
you merge emails, writing and inserting different fields, preview results and convert a file into a PDF 
format. The Mailings tab has five groups of related commands; Create, Start Mail Merge, Write & Insert 
Fields, Preview Results and Finish. 

See the image: 

 

Review tab: 

It is the sixth tab in the Ribbon. This tab offers you some important commands to modify your document. 
It helps you proofread your content, to add or remove comments, track changes, etc. The Review tab has 
six groups of related commands; Proofing, Comments, Tracking, Changes, Compare and Protect. 

See the image: 

 

 
 
View tab: 

The View tab is located next to the Review tab. This tab allows you to switch between Single Page and 
Two Page views. It also enables you to control various layout tools like boundaries, guides, rulers. Its 
primary purpose is to offers you different ways to view your document. The View tab has five groups of 
related commands; Document Views, Show/Hide, Zoom, Window and Macros. 

See the image: 
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Ruler 

The Ruler is located below the Ribbon around the edge of the document. It is used to 
change the format of the document, i.e. it helps you align the text, tables, graphics and 
other elements of your document. It uses inches or centimeters as the measurements unit 
and gives you an idea about the size of the document. 

See the image: 

 

 

TEXT BASICS 
How to Insert Text in MS Word 

The basic steps to insert text or to create a new document in Word are listed below; 

o Go to the start menu and look for Microsoft Word icon 

o Click the icon to open the Microsoft Word 

o You will see a blinking cursor or insertion point in the text area below the ribbon 

o Now, as you start typing, the words will appear on the screen in the text area 

o To change the location of insertion point press spacebar, Enter or Tab keys 

See the image:  
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How to Delete Text in MS Word 

You can easily delete the text in Word including characters, paragraphs or all of the content 
of your document. Word offers you different methods to delete the text; some of the 
commonly used methods are given below; 

o Place the cursor next to the text then press Backspace key 

o Place the cursor to the left of the text then press Delete key 

o Select the text and press the Backspace or Delete key 

o Select the text and type over it the new text. 

 

 

How to Select Text in MS Word 

Place the cursor next to the text then left click the mouse and holding it down move it over 
the text then release it. The text will be selected. 

Some shortcuts for selecting text are: 

o To select a single word double click within the word 

o To select the entire paragraph triple click within the paragraph 

o To select entire document, in Home tab, in Editing group click Select then choose 
Select All option or press CTRL+A 
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o o Shift + Arrow; hold down the shift key then press the arrow key, the word will 
select the text in the direction of the arrow key. There are three arrow keys, so you 
can select the text in three different directions. 

See the image: 

 

How to Copy and Paste Text in MS Word 

Word offers different methods to copy and paste text. Some of the popular methods are 
given below. 

Method 1: 

o Select the text you want to copy 

o Select the Home tab and click the Copy command 

o Place the cursor where you want to paste the text 

o Click the Paste command in Home tab 

Method 2: 

o Select the text 

o Place the cursor over the text and right click the mouse 
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o A menu will appear; with a left click select the "Copy" option 

o Now, move the cursor to a desired location and right click the mouse 

o A menu will appear; with a left click select the 'Paste" option. 

See the image: 

 

How to Save the Document in MS Word 

When you create a document it is important to save the document so that it can be viewed 
or reused later. The basic steps to save a document are listed below; 

o Click the Microsoft Office Button 

o A list of different commands appears 

o Click the 'Save As' command 

o it displays 'Save As' Dialogue Box 

o Save the document to desired location with a desired name 
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You can also choose 'Save' command from the list to save the document to its current 
location with same title. If you are saving a fresh document it displays 'Save As' dialogue 
box. 

The shortcut method to save a document is to press "Ctrl+S" keys. It opens the 'Save As' 
dialogue box where you can name you document and save it to a desired location. 
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Proofing Features 
How to Correct Errors in MS Word 

When you type text in a document, by default the Word informs you if there is any 
contextual, spelling or grammatical error. Word informs you in different ways for different 
errors; 

If there is any contextual error in the document, it will underline the text with blue line. 

If there is any spelling error in the document, it will underline the text with red line. 

If there is any grammar error in the document, it will underline the text with green line. 

See the image: 

 

Steps to correct errors: 

o Place the cursor over the text that you want to correct 

o Right click the mouse 

o A list of suggestions appears 

o Choose the correct word with a left click 
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See the image: 

 

 

How to Check Word Count in Ms Word 

When you start typing, the Word automatically counts the number of words and number of 
pages and displays the information on the status bar. If the word count is not available on 
the status bar, you can right click the status bar and select the Word Count option from the 
menu. Basic steps to check the word count are listed below; 

o Open the document 

o Look at left bottom corner of the document 

o You will see the total world count and the number of pages 

See the image: 

 

To know the word count of a specific line or paragraph you have to select it then Word will 
display its word count along with the total word count, e.g. 15/40. In this example, the 
selection has 15 words out of the total number of words (40). 
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Formatting Text 
How to Change Font Size in MS Word 

You can easily change the font size of your text in the document. The basic steps to change 
the Font size are listed below: 

o Select the text that you want to modify 

o In Home tab locate the Font group 

o In Font group click the drop-down arrow next to font size box 

o Font size menu appears 

o Select the desired font size with a left click 

o Select the text and click the increase or decrease font size buttons 

See the image: 

 

 

How to Change Font Style in MS Word 

The basic steps to change the font of a text in a document are given below; 

o Select the text you want to modify 

o Select the Home tab and locate the Font group 

o Click the drop-down arrow next to font style box 

o Font style menu appears 

o With a left click select the desired font style 

o If you want to change the font to bold or italic, click the 'B' or 'I' icons on the format 
bar. 
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See the image: 

 

 

How to Format Font Color in MS Word 

MS Word allows you to change the Font color of your text. If you want to emphasize a 
particular word or phrase, you can change its font color. The basic steps to change the Font 
color are given below; 

o Select the text you want to modify 

o In Home tab locate the Font group 

o Click the drop-down arrow next to Font color button 

o Font color menu appears 

o Select the desired font color with a left click 

o Word will change the Font color of the selected text. 

See the image: 
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How to Change Text Case in MS Word 

You can easily change the text case in your document by following the steps given below; 

o Select the text you want to change 

o In Home tab locate the Font group 

o Click the drop-down arrow in 'Change Case' button 

o It displays text case menu 

o Select the desired case with a left click 

The case menu offers four options; 

Sentence case: It capitalizes the first letter of each sentence. 

Lowercase: It changes the text from uppercase to lowercase. 

Uppercase: It capitalizes all the all letters of your text. 

Capitalize Each Word: It capitalizes the first letter of each word. 

Toggle Case: It allows you to shift between two case views, e.g. to shift between Capitalize 
Each Word and cAPITALIZE eACH wORD. 

See the image: 
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How to Change Text Alignment in MS Word 

You can change the text alignment in your document to make it more presentable and 
readable. The basic steps to change the text alignment are given below; 

o Select the content you want to modify 

o In Home tab locate the Paragraph group 

o It has four alignment options ; 

Align Text Left: Aligns the text towards left margin 

Center: Brings the text at center 

Align Text Right: Aligns the text towards right margin 

Justify: Aligns the text to both left and right margins 

o Select the desired alignment option with a left click 

See the image: 
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How to Insert a Text Box in MS Word 

Text box allows you to control the position of a block of text in your document. You can also 
format them with borders and shading. The two commonly used methods to insert Text 
Boxes are given below: 

Method 1: 

o Select the Insert tab 

o Locate the Text group 

o Click the Text Box button 

o It displays Built-In text box menu and an option to draw table 

o With a left click select the desired text box format from the menu 

Method 2: 

 Select 'Draw Text Box' option 
 A cross shaped cursor appears 
 Left click the mouse and holding it down drag it to draw the box of desired 

dimensions 

See the image: 
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Bold, Italic and Underline Commands in MS Word 

These commands are given in the Font group in the Home tab. Their functions are given 
below; 

o Bold: It allows you to Bold the text of your document 

o Italic: It allows you to Italicize the text of your document 

o Underline: It allows you to underline the text of your document 

See the image: 

 

 

 

Formatting Paragraph 
 

How to Create First Line Indent in MS Word 

You can create indent within your paragraph by following these steps: 

o Select the paragraph or place the cursor anywhere within the paragraph 

o Select the Home tab 

o Locate the Paragraph group and click the arrow at right bottom corner 

o 'Paragraph' dialog box appears 

o In 'Indents and Spacing' section click the drop down arrow in 'Special' field 

o Select the 'First Line' option 

o Enter desired indent in 'By' field and click Ok 
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See the image: 

 

 

How to Apply Style in MS Word 

You can create professional and presentable documents in MS Word by applying different 
styles. The basic steps to apply a style in a document are listed below; 

o Select the text to which you want to apply the style 

o Select the Home tab 

o In Styles group you will see different styles 

 

o To view more styles click the drop-down arrow 

o It displays style menu 

o Select the desired style with a left-click 
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How to Customize Style in MS Word 

If you are looking for formatting options that are not given in the built-in styles, you can 
modify or customize an existing style to fulfill your needs. The steps to customize a style are 
as follows; 

o Select the style that you want to modify 

o Right click the mouse 

o It displays a list of different commands 

o Select the 'Modify' option 

 

o 'Modify Style' dialogue box appears 

 



__________________________________________________________________________________ 
GYANENDRA SHUKLA 
gyanendrashukla01@gmail.com 
+-91-9718246894 

See the image: 

 

 

o Make the desired changes to formatting 

o Click OK to apply the changes to style 

How to Create New Style in MS Word 

You can add new styles to your list of styles, i.e. Word allows you to set the styles for font, 
figure, paragraph, etc. It helps you to keep consistency in all the documents of a topic or 
subject. The steps to create new styles are given below; 

o Select the Home tab 

o In Styles group click the arrow at the right bottom corner of the group 

o It displays the 'Styles' task pane 

 

In 'Styles' task pane click the 'New Style' button 

It displays 'Create New Style from Formatting' dialogue box 
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o Enter the name for new style and make all the desired changes 

o Click OK, the new style will be added to the list of styles 
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Modify Page Layout 
 

How to Change Page Orientation in MS Word 

Page Orientation refers to the direction in which a document is displayed. It is of two types; 
portrait (vertical) and landscape (horizontal). The default orientation is portrait; it can be 
changed to landscape by following these steps; 

o Select the Page Layout tab 

o Locate the Page Setup group 

o In Page Setup group click the Orientation command 

o It displays two options, Portrait and Landscape 

o Select the desired page orientation 

See this images: 

 

How to Change Page Size in MS Word 

The default paper size in Word is 8.5 x 11 inches which easily fits in printers. This size is not 
fixed; you can change it if you want a document with different paper size. The steps to 
change the paper size are given below; 

o Click the Page Layout tab 

o In Page Setup group click the Size command 

o Paper size menu will appear 

o With a left click select the desired paper size 

o To customize page size click the 'More Paper Sizes' option 
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See this images: 

 

 

How to Change Page Margins in MS Word 

The margin is the space between the text and border of a document. By default, it is a one-
inch space. Depending on your needs, it can be changed by following the below-listed steps; 

o Select the Page Layout tab 

o In Page Setup group click the Margins command 

o A list of Margins appears 

o Select the desired Margin with a left click 
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See the image: 

 

To customize Margins select 'Custom Margins'. It displays a 'Page Setup' dialog box. 

Enter the desired margin size and click Ok. 

See the image: 
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How to Insert Page Break in MS Word 

Word inserts a page break at the end of each page. It also allows you to insert a page break 
at some other place in the document. The steps to insert page break are given below; 

o Place the cursor where you want to insert the break 

o Select the Page Layout tab 

o In Page Setup group click the 'Breaks' command 

o A list of Page Breaks appears 

o With a left click select the desired page break from the list 

See the image: 
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How to insert a header and footer in Microsoft Word document 

In Microsoft Word, Headers and Footers are used to insert additional information such 
as title, file name, date, page numbers, etc. The presence of both header and footer in the 
Word document makes your document more professional and easier to read as well as 
understand. 

Headers appear at the top margin of the Word document, while Footers appear at 
the bottom margin of the Word document. 

To insert a header and footer in Microsoft Word, follow the below given basic steps – 

Step 1: Open the new or an existing Word document in which you want to insert header and 
footer. 

Step 2: Go to the Insert tab at the top of the Ribbon. 

Step 3: Click on either header or footer drop-down menu in the Header & Footer section. 

 

Step 4: A Header or Footer drop-down menu will display on the screen with a list of built-in 
Header or Footer options. Select your desired option from the Built-in list. 

 

Step 5: A Design tab with Header & Footer option will appear at the top of the document 
(on the Ribbon), as shown in the below screenshot. 



__________________________________________________________________________________ 
GYANENDRA SHUKLA 
gyanendrashukla01@gmail.com 
+-91-9718246894 

 

Step 6: Type your desired information into the header or footer section. 

 

Step 7: Once you type your desired text in the Header section, click on Close Header and 
Footer under the Design section on the Ribbon or press the Esc key from the keyboard to 
remove the dotted underline. Now, you can see that the Header is inserted to the Word 
document. 

 

Insert the Date or Time in a Header or Footer 

To insert the Date or Time in a Header or Footer, follow the below instructions - 

1. Go to the Insert tab on the Ribbon and click on the Date & Time option in 
the Text section. 
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2. A Date and Time dialog box will appear on the screen in which do the following - 

o Select Date format from the Available format. 

o Select your desired language. 

o Tick on the Update automatically checkbox. 

o Click on the OK button at the bottom of the dialog box. 

 

Now, you can see that your selected format will appear on the Word document. 

Edit Header and Footer in Word document 

Once you create Header and Footer in Word document, you can also edit it based on your 
requirement. 

There are the following steps to edit Header and Footer in Word document. 

Step 1: Go to the Insert tab on the Ribbon and click on either Header or Footer drop-down 
menu that you want to Edit. 

Step 2: A Built-In Header option window will appear on the screen. Click on the Edit 
Header option. 
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Step 3: Edit Header based on your requirement. Once you edit Header, click on 
the Close Header and Footer option at the top right corner of the document to disappear 
the blue dotted lines. 

 

Now, you can see that Header is edit based on your requirement. 

 

Delete Header and Footer from Word document 

To Delete Header and Footer from Word document, follow the below steps - 

1. Go to the Insert tab on the Ribbon and click on the Header & Footer option. 

2. A Header or Footer dialog will appear on the screen. Click on the Remove Header or 
Remove Footer option. 
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Working with Tables 

How to Insert Table in MS Word 

Table is a versatile tool of MS Word. It allows you to organize your information, i.e. you can 
align text, present numerical data and create forms and calendar. The steps to insert table 
are given below; 

o Place the cursor where you want to insert the table 

o Select the Insert tab 

o In Tables group click the Table command 

o It displays different options to insert the table 

o Select the desired option to insert the table 

See the image: 

 

To Convert Text to Table 

o Select the text 

o Select the Insert tab 

o In Tables group click the Table command 

o Select the 'Convert Text to Table' option 
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o It displays a dialog box 

o In 'Separate text at' section select the desired option 

o Click OK, the text will convert to a table 

See this image: 

 

 

How to Add Row in Table 

If you want to increase or add a new row in your table, you can follow the steps given 
below; 

o Place the cursor in a row above or below which you want to add row 

o Right click the mouse 

o A menu appears 
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o Place the arrow over Insert option 

o It will display a menu 

o As required select 'Insert Rows Above' or 'Insert Rows Below' 

See this images: 

 

How to Add Column in Table 

If you want to increase or add a new column in your table, you can follow these steps; 

o Place the cursor in the column adjacent to which you want to add the column 

o Right click the mouse 

o It displays a menu 

o Place the arrow over Insert option 

o It shows a list of commands 

o As required select 'Insert Columns to the Right' or 'Insert Columns to the Left' 

See the image: 
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How to Delete Column or Row in Table 

The table command also allows you to delete a column or row in your table. You can delete 
the unwanted columns or rows by following these steps; 

o Select the column or row of the table 

o Right click the mouse 

o A menu appears 

o As required select 'Delete Columns' or 'Delete Rows' 

See the image: 

 

How to Modify Table 

Word allows you to customize tables as per your requirement. You can modify your table in 
different ways, i.e. you can choose a table style, table design, draw borders. The steps to 
modify a table are given below; 

o Select the table 

o Two new tabs Design and Layout appear on the Ribbon 

o On Design tab you will see three groups of commands to modify table; Table Style 
Options, Table Styles and Draw Borders: 
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o Layout tab has six groups of commands to format table 

 

How to Split Text to Columns 

You can split your text to columns as shown in the image given below. It helps you make 
your text more readable and presentable. The steps involved in this process are given 
below: 

o Open the document 

o Select the Page Layout tab 

o In Page Setup group click the Columns command 

o It displays a list of options to split text into columns 

o Select the desired option 

See the image: 
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Inserting Illustrations 
 

How to Insert Smart Art Graphics 

You can insert Smart Art Graphics in your document to effectively communicate your 
message. You can insert a process flow, a relationship or an organization hierarchy. The 
steps to insert smart art graphics are given below; 

o Place the cursor in the document where you want to insert graphics 

o Select the Insert tab 

o In Illustrations group select the 'Smart Art' command 

 

o On left side, a dialog box appears with list of categories 

o In the center you will see the illustrations available in a category 

o Select the desired illustration and click Ok 

See the image: 
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How to Add Text in Smart Art Graphics 

Word also allows you to add text in Smart Art Graphics; you can add facts, figures and any 
other information. The steps to add smart art graphics are given below; 

o Select the graphic 

o Task pane appears on the left side if it is not visible then click the arrow on left side 
of graphic 

o Type the text in task pane fields it will appear in the graphic 

o You can also directly type the text in the graphic in text area 

o Close the task pane after entering the text and click outside the graphic 

See the image: 

 

How to Insert Picture in Document 

Pictures make our text more attractive and readable. You can insert relevant pictures in your text by 
following these steps: 

o Place the cursor where you want to insert the picture 

o Select the Insert tab on Ribbon 

o In Illustrations group click the Picture command 

 

o It displays 'Insert Picture' dialog box 
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o Select the desired image 

o Click Insert to insert the picture 

See the image: 

 

How to Insert Clip Art 

Clip art refers to a graphic or a picture that you can insert in your document. It comes in 
different formats and styles. It is used to enhance the appearance of a document. The steps 
to insert a clip art are given below; 

o Place the cursor where you want to insert the clip art 

o Select the Insert tab 

o In Illustrations group click the Clip Art command 

 

o A task pane appears on the right side of document 

o Enter the keyword in 'Search for' field and select the suitable option in 'Search in' 
and 'Results should be' fields 
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o Click Go, clip art menu will appear 

o Select the desired clip art with a left click 

See the image: 

 

How to Format Picture or Clip Art 

You can change the appearance of your picture or clip art to enhance its visual impact. The 
format tab offers you various options for formatting pictures like contrast, changing color, 
line style, cropping, etc. The steps to format picture or clip art are given below; 

o Select the picture or clip art that you want to format 

o Format tab appears in the Ribbon 

o Click the Format tab 

o It displays four groups of related commands to modify or format picture or clip art 

See the image: 
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Working with Lists 
 

How to Create Bulleted and Numbered Lists 

Bullets and numbers are used to make a list more presentable and readable. A bulleted list 
attracts more than a simple list. Word offers you various styles of bullets and numbers. The 
steps to create bulleted lists are given below; 

o Select the text you want to convert to bulleted or numbered list 

o Select the Home tab 

o In Paragraph group click the Bullets or Numbering command 

o It displays Bullets or Numbering menu 

o With a left click select the desired Bullet or Numbering style 

o To increase the list place the cursor at the end of list and press Enter key 

See the image: 

 

How to Use Symbols as Bullets 

You can replace the bullets with symbols to make your lists more meaningful and attractive. 
The steps involved in this process are given below; 

o Select the text to convert to bulleted list 

o Select the Home tab 

o In Paragraph group click the Bullets command 

o Click 'Define New Bullet' option 

o 'Define New Bullet' dialog box appears 
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o Click the Symbol command 

o It displays 'Symbol' dialog box 

o Select the desired symbol 

o For more options click the drop down arrow next to Font field 

See the image: 
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Using WordArt 
 

How to Insert WordArt 

Word Art is designed to allow you make your text more attractive; you can format your text 
to make it look like a picture and enhance its appearance in different ways. The steps to 
insert WordArt are given below; 

o Place the cursor where you want to insert WordArt 

o Select the Insert tab 

o In Text group click the 'WordArt' button 

o WordArt menu appears 

 

o Select the desired WordArt style 

o 'Edit WordArt Text' dialog box appears 

o Type the text in text area and click OK 

See the image: 
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How to Format WordArt 

Word also allows you to customize WordArt. You can change WordArt shapes, font face and 
size, and colors as per your requirement. The steps to format WordArt are given below; 

o Select the word art in the document 

o Format tab appears in the Ribbon 

o It offers five groups of related commands 

o Click the suitable command to make desired changes in word art 

See the image: 

 

 

 

 

 

 

 

 

 

 

 

 

(Ref:  www.google.com) 



MS

A disk operating system (DOS) is an operating system for x86 based personal computers mostly 
developed by Microsoft. MS-DOS, 
attempting to be compatible with MS
the generic acronym for disk operating system.

MS-DOS was the main operating system for IBM PC compatible personal computers during the 
1980s. It was gradually superseded by operating systems offering a graphical user interface 
(GUI) in various graphical Microsoft Windows operating system generations.

DOS is also used to describe several similar command
computers, such as the Commodore 64, Atari 800, and Apple II, all featured a disk operating 
system, including Commodore Business Machines DOS, Atari DOS, and Apple DOS, respectively. 
DOS/360 was an OS for IBM mainframes, which first appeared in 1966, but it is unrelated to the 
8086-based DOS of the 1980s. 

Several competing products were released for the 
DOS went through eight versions until development ceased in 2000. Initially, MS
targeted at Intel 8086 processors running on c
access the operating system, application software, and user data

Progressive version releases delivered support for other mass storage media in ever greater 
sizes and formats and added feature support for 

MS-DOS Operating System 

A disk operating system (DOS) is an operating system for x86 based personal computers mostly 
DOS, it’s rebranding as IBM PC DOS, and some operating systems 

attempting to be compatible with MS-DOS. Sometimes it is referred to as "DOS", which is also 
the generic acronym for disk operating system. 

DOS was the main operating system for IBM PC compatible personal computers during the 
1980s. It was gradually superseded by operating systems offering a graphical user interface 

various graphical Microsoft Windows operating system generations. 

DOS is also used to describe several similar command-line disk operating systems. Early 
computers, such as the Commodore 64, Atari 800, and Apple II, all featured a disk operating 
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Several competing products were released for the x 86 platforms during its lifetime, and MS
DOS went through eight versions until development ceased in 2000. Initially, MS
targeted at Intel 8086 processors running on computer hardware using floppy disks to store and 
access the operating system, application software, and user data. 

Progressive version releases delivered support for other mass storage media in ever greater 
sizes and formats and added feature support for newer processors and rapidly evolving 

A disk operating system (DOS) is an operating system for x86 based personal computers mostly 
rebranding as IBM PC DOS, and some operating systems 
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DOS was the main operating system for IBM PC compatible personal computers during the 
1980s. It was gradually superseded by operating systems offering a graphical user interface 
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computer architectures. Microsoft's development was the key product from a programming 
language company to a diverse software development firm, providing essential revenue and 
marketing resources. It was also the underlying basic operating system on which early versions 
of Windows ran as a GUI. 

How DOS works? 

When a computer is powered on, it goes through various steps called the boot process. For a 
computer running a disk operating system in the following six steps, such as: 

1. The read-only memory (ROM) bootstrap loader reads the Master Boot Record and 
passes control over to it. 

2. The boot record loads the disk operating system into memory, and it takes control of 
the machine. 

3. The computer transfers data stored on a magnetic disk to its main memory, the random 
access memory. 

4. It also transfers data to external devices attached to the computer, such as a computer 
screen or printer. 

5. The computer provides various applications programming interfaces for programs like 
character input/output, memory management, program loading, termination, and 
handling input from the user through a keyboard. 

6. The OS also provides file management that organizes, reads, and writes files on storage. 
The files are organized in a hierarchical structure of directories, subdirectories, and files. 

A disk operating system doesn't have a graphical user interface (GUI). Its interface is character-
based, so users must type commands in the command line to indicate what actions they want. 

Features of DOS 

Here are some of the distinguishing features of a disk operating system, such as: 

o MS-DOS does not offer GUI (Graphical User Interface) and doesn't accept mouse inputs. 
It is a character-based interface system where all commands are entered in the text at 
the command-line prompt. 

o A disk operating system manages files, folders and allows program loading and 
execution. It can control hardware devices such as disk, memory and allocate resources. 

o MS-DOS offers a file system to organize, read and write files to the disk storage. 
o It is a single-user operating system and performs various tasks to ensure the proper 

operation of systems. 



o It uses a 16-bit file allocation table (FAT16), and a 16-bit interface is used to define the 
location of the memory of each file uniquely. These identifiers are stored in a tabular 
format with the name File Allocation table. 

o MS-DOS does not support a multiuser operating system, and it is less secure and does 
not have a concept of user roles. It is very lightweight due to its basic interface and 
limited features. 

Limitations of MS-DOS 

Here are the following limitations of the disk operating system, such as: 

o Built-in security: DOS does not have built-in security, such as file ownership and 
permissions. 

o No multiuser or multitasking: It also does not support multiuser or multitasking. It can 
only run one program at a time, but it provides direct access to the basic I/O system and 
underlying hardware. 

o Challenging interface: A user must type in commands and remember commands to run 
programs and other OS tasks. For example, typing the command cd 
\directory_name changes the current working directory to the named directory, and 
typing the command dir lists the files in the current directory. This approach makes it 
difficult for beginners to use. 

Types of MS-DOS Commands 

An instruction given to a computer to perform a specific task is known as a command. The MS-
DOS has many commands to perform each task, and these commands are stored in the DOS 
directory of the disk. The MS-DOS commands are of two types, internal command, and external 
command. 

1. Internal Command: Internal commands are built-in commands of MS-DOS, stored in the 
command interpreter file (COMMAND.COM). These commands reside in memory if the 
system is at prompt (C:\>) level. Some of the internal commands are DATE, TIME, DIR, 
VER, etc. 

2. External Command: External commands are separate program (.com) files that reside in 
the DOS directory. 

Commands Description 



Dir List all files of specific directories or subdirectories. 

CD or CHDIR Navigate or move to a specific directory. 

RD or RMDIR Remove directory. 

TREE Display all directory paths. 

PATH Set sequential search path for executable files. 

SUBST Substitutes a string alias for the pathname. 

FORMAT Formats a disk for DOS files. 

COPY Copies one or more files to another location. 

XCOPY Copy files and directories and their subdirectories. 

Del Delete files. 

Ren or 
rename 

Rename the name of a file or directory. 

ATTRIB Set or show file attributes. 

BACKUP Backup files and directories. 

PROMPT Customize DOS prompt. 

Deltree Deletes all files and subdirectories from a computer. 

Help Lists the available commands or more information about a specific command. 



mkdir or md Creates a new subdirectory. 

Move Moves files or directories from one directory to another or from one drive to 
another. 

Type Displays the contents of a file on the screen. 

* A wildcard character that represents one or more characters a group of files has in 
common. 

? A wildcard character that represents a single character a group of files has in 
common. 

MS-DOS Files and Filenames 

One of the primary functions of the OS is to handle disk files. A file can contain only data, or it 
can contain a set of instructions, called a program, telling the computer how to perform a 
particular task. Every file has associated with it a unique filename which is used to identify it on 
the disk. A filename in MS-DOS has two parts; the name and an extension. 

The name can contain up to eight characters. Each filename can have a three-character 
extension. The extension is separated from the name by a period. The period serves as 
a delimiter, indicating where one portion of the filename ends, and the next begins. An 
extension is usually used to identify files that are related in some way. MS-DOS allows the 
following characters to be used in a filename and extension: 

o Uppercase and lowercase case letters A through Z 
o Numbers 0 through 9 
o Special characters $ # & @ ( ) ! ^ ` ~ { } 

Any other character used in a filename, including spaces, will cause the name to be terminated 
at that character. It is generally good practice not to use special characters in filenames because 
some programs may use them as delimiters or other special purposes. 

In addition, the extensions BAT, COM, EXE, and SYS have special meanings in MS-DOS and 
should therefore normally not be used with your data files. Shown below are examples of both 
valid and unacceptable filenames. 

 



Valid MS-DOS Filenames: 

o BEERSLAW 
o DAT 
o 1 
o EXP 

Invalid MS-DOS Filenames: 

o EXP 1.DAT (space is not allowed) 
o BEERSLAWDATA (too many characters in the name) 
o EXP1 (too many characters in the extension) 
o HG>HE (> is an invalid character) 

 



 

UNIT- II 

Cloud Computing Architecture-Introduction – Internet as a Platform, The cloud reference model 

- Types of clouds - Economics of the cloud, Computing platforms and technologies, Cloud 

computing economics, Cloud infrastructure - Economics of private clouds - Software 

productivity in the cloud - Economies of scale: public vs. private clouds. 

 

 

 

 

 

 



 

Cloud Computing Architecture 

As we know, cloud computing technology is used by both small and large organizations to store the 

information in cloud and access it from anywhere at anytime using the internet connection. 

Cloud computing architecture is a combination of service-oriented architecture and event-driven 

architecture. 

Cloud computing architecture is divided into the following two parts - 

 Front End 

 Back End 

 

 



 
 



 

Front End 

The front end is used by the client. It contains client-side interfaces and applications that are required to 

access the cloud computing platforms. The front end includes web servers (including Chrome, Firefox, 

internet explorer, etc.), thin & fat clients, tablets, and mobile devices. 

Back End 

The back end is used by the service provider. It manages all the resources that are required to provide cloud 

computing services. It includes a huge amount of data storage, security mechanism, virtual machines, 

deploying models, servers, traffic control mechanisms, etc. 

 

 

 



 

Components of Cloud Computing Architecture 

There are the following components of cloud computing architecture - 

1. Client Infrastructure 

Client Infrastructure is a Front end component. It provides GUI (Graphical User Interface)  to interact with 

the cloud. 

2. Application 

The application may be any software or platform that a client wants to access. 

3. Service 

A Cloud Services manages that which type of service you access according to the client’s requirement. 

 



 

Cloud Deployment Models: 

• National Institution of Standards and Technology (NIST) operate under the US Department of 

Commerce and has defined many of the key concepts used in cloud computing.  

• NIST Special Publication 800-145 identifies four models for cloud deployments. These are: 

1. Public Cloud 

2. Private Cloud 

3. Community Cloud 

4. Hybrid Cloud  



 

Cloud Deployment Models: 

• Private cloud – owned by a single organization 

• Public cloud – accessible to the public 

• Community cloud – shared by a group of 

organizations 

• Hybrid cloud – a combination of the above three 

clouds 



 

Public Cloud 

• Public clouds are external publicly available 

environments accessible to multiple tenants. 

• The cloud provider is responsible for the creation and 

the on-going maintenance of the public cloud and its 

IT resources. 

• Public clouds are ideal for individuals, startups and 

other organizations with financial restrictions. 

• Some of the Public cloud examples include Amazon 

Web Services, Microsoft Azure, IBM Cloud and 

Google Cloud Platform. 



 

 
 

 

 

 

 

 

 

 



 

The Case of Public Cloud 
Consider this, 

Connected Solutions is a startup venture started by four classmates who are 

interested in developing IoT (Internet of Things) solutions. However, when it comes 

to investing in infrastructure like storage and networking, finance is an issue. What 

would Connected Solutions do? 

• If you are limited in financial resources but still require a good amount of space 

to store your data, using a public cloud is the best option. 

• There are good public cloud pricing plans that offer good amount of storage. 

• Additionally, public clouds tend to use the latest technological advancements (hardware, 

software and so on), have better utilization rates, provide greater elasticity and continually test 

your applications and networks. 

 



 

Private Cloud 

• A Private Cloud is owned by a single organization. 

• Private cloud helps an organization in centralizing the 

access of IT resources by its various locations and 

departments. 

• Private clouds are ideal especially for organizations that 

have heavily invested in infrastructure. 

 

 

 



 

The Case of Private Cloud 

Consider this as an example,  

You are a financial organization with a big infrastructure. You deal with sensitive information, 

hence, security is of utmost importance. You want your infrastructure to be centralized, secure 

and to have a greater control over it. What is your best option? 

• A private cloud though expensive, comes with greater security 

and control. 

• A private cloud is custom designed by you for your business. 

• It allows for rapid scaling of business operations. 

• And most importantly, when issues arise you can prioritize and 

handle them unlike a public cloud where the delays in resolving 

an issue may pile up. 



 

Public Cloud vs. Private Cloud 

Private clouds combine the security of keeping resources inhouse with the 

scalability of the cloud by storing resources privately. Therefore, they are an ideal 

solution for companies with compliance requirements who cannot host their 

resources on a public cloud. 

However, public clouds are best when facing financial 

restrictions and are not dealing with sensitive information. 



 

Public Cloud vs. Private Cloud 

 



 

Community Cloud 

• Community cloud model is shared by a group of organizations with similar 

requirements such as security, compliance and IT 

policies. 

• The community cloud may be jointly owned by the 

community members or by a third-party cloud 

provider that provisions a public cloud with limited 

access. 

The Case of Community Cloud 

• For example, the Department of Defense and some 

intelligence agencies have launched data centre 

improvement initiatives using a community cloud. 

This enables them to easily share data with other 

agencies in the community cloud, while still keeping it secure and controlled. 



 

• Another industry taking advantage of community clouds is the healthcare industry, where everyone 

in the community can support patients and exchange data in a controlled way. 

• Uses of community cloud: 

1. Allows for easy sharing and collaboration 

2. Lowers costs 

Hybrid Cloud 

• Hybrid cloud is a combination of two or more models, 

private cloud, public cloud or community cloud. 

• For example, a cloud consumer may choose to deploy cloud services processing sensitive data to a 

private cloud and other less sensitive cloud services to a public cloud. The result of this 

combination is a hybrid deployment model. 



 

 

The Case of Hybrid Cloud 

Consider a business with dynamic work load that experiences significant hike in business during 

holiday season. They require more resources to handle the peak season. However, these resources are 

not required for the rest of the year. What would be the best option? 

A hybrid cloud - A private cloud for off season operations and public cloud services for the holiday 

season is an ideal combination for such a business.  



 

 

 

 

 

 

 

 



 

Other Deployment Models: 

There are other variations of the basic cloud deployment models 

such as: 

Virtual Private Cloud: also called ‘dedicated cloud’ or ‘hosted 

cloud’ is a self-contained cloud environment hosted and managed 

by a public cloud provider. 

 

 

 

 

 

 

 

 

 



 

 

Inter-Cloud: comprised of two or more interconnected clouds. 

Google 

Salesforce 

Zoho 

Yahoo 

Amazon 

Microsoft 

Intercloud 



 

 

 

 
 

 



 

Advantages of Cloud Computing 

1. Cost Efficient – the pay-as-you-go model significantly minimizes the organization’s costs. 

2. Almost Unlimited Storage – Using cloud storage means unlimited storage capability. No running 

out of storage or no need of investing in storage devices. 

3. Backup and Recovery – all the data are backed up on to the cloud. Hence, backup and recovery 

becomes more easier. 

4. Automatic Software Integration – the changes to the software made by different developers are 

tested and integrated several times in a day. This is automatically done when using cloud. 

5. Easy Access to Information – once registered, information can be accessed from any location 

and from any device. 

6. Quick Deployment – using cloud you can get your entire system fully functioning in just a couple 

of minutes. 



 

Disadvantages of Cloud Computing: 

1. Technical issues: 

Though cloud enables you to access information from anywhere and on any device, 

however, the system can sometimes malfunction and besides that you also need a strong 

internet connection.  

2. Security in Cloud: 

You should always be careful to choose the most reliable service provider since the 

company’s sensitive information is being handed over to a third party for storage. 

3. Prone to Attack: 

Storing information in the cloud makes it accessible to hackers. 



UNIT- III

Principles of Parallel and Distributed Computing: Parallel vs. distributed

computing - Elements of parallel computing - Hardware architectures for

parallel processing, Approaches to parallel programming - Laws of caution.
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Parallel Computing

• Parallel computing is the process of performing computational tasks across multiple

processors at once to improve computing speed and efficiency. It divides tasks into sub-

tasks and executes them simultaneously through different processors.

• There are three main types, or “levels,” of parallel computing: bit, instruction, and task.

• Bit-level parallelism: Uses larger “words,” which is a fixed-sized piece of data handled as

a unit by the instruction set or the hardware of the processor, to reduce the number of

instructions the processor needs to perform an operation.

• Instruction-level parallelism: Employs a stream of instructions to allow processors to

execute more than one instruction per clock cycle (the oscillation between high and low

states within a digital circuit).

• Task-level parallelism: Runs computer code across multiple processors to run multiple

tasks at the same time on the same data.

2
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Distributed Computing

• Distributed computing is the process of connecting multiple computers via a local

network or wide area network so that they can act together as a single ultra-powerful

computer capable of performing computations that no single computer within the

network would be able to perform on its own.

Distributed computers offer two key advantages:

• Easy scalability: Just add more computers to expand the system.

• Redundancy: Since many different machines are providing the same service, that

service can keep running even if one (or more) of the computers goes down.

3



• Key Differences Between Parallel Computing and Distributed Computing
• While parallel and distributed computers are both important technologies, there are several key

differences between them.

• Difference #1: Number of Computers Required

• Parallel computing typically requires one computer with multiple processors. Distributed computing, on
the other hand, involves several autonomous (and often geographically separate and/or distant)
computer systems working on divided tasks.

• Difference #2: Scalability

• Parallel computing systems are less scalable than distributed computing systems because the memory of
a single computer can only handle so many processors at once. A distributed computing system can
always scale with additional computers.

• Difference #3: Memory

• In parallel computing, all processors share the same memory and the processors communicate with each
other with the help of this shared memory. Distributed computing systems, on the other hand, have their
own memory and processors.

• Difference #4: Synchronization

• In parallel computing, all processors share a single master clock for synchronization, while distributed
computing systems use synchronization algorithms.

• Difference #5: Usage

• Parallel computing is used to increase computer performance and for scientific computing, while
distributed computing is used to share resources and improve scalability.
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Hardware Architectures For Parallel Processing

• Flynn’s taxonomy is a classification scheme for computer architectures proposed by Michael Flynn in 1966. The

taxonomy is based on the number of instruction streams and data streams that can be processed

simultaneously by a computer architecture.

There are four categories in Flynn’s taxonomy:

• Single Instruction Single Data (SISD): In a SISD architecture, there is a single processor that executes a single

instruction stream and operates on a single data stream. This is the simplest type of computer architecture and

is used in most traditional computers.

• Single Instruction Multiple Data (SIMD): In a SIMD architecture, there is a single processor that executes the

same instruction on multiple data streams in parallel. This type of architecture is used in applications such as

image and signal processing.

• Multiple Instruction Single Data (MISD): In a MISD architecture, multiple processors execute different

instructions on the same data stream. This type of architecture is not commonly used in practice, as it is

difficult to find applications that can be decomposed into independent instruction streams.

• Multiple Instruction Multiple Data (MIMD): In a MIMD architecture, multiple processors execute different

instructions on different data streams. This type of architecture is used in distributed computing, parallel

processing, and other high-performance computing applications.
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• Flynn’s taxonomy is a useful tool for understanding different types of computer architectures and their 

strengths and weaknesses. The taxonomy highlights the importance of parallelism in modern computing 

and shows how different types of parallelism can be exploited to improve performance.

• Systems are classified into four major categories:
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• Parallel Programming Models

• There are several parallel programming models in common use: 

• Shared Memory (without threads)

• Threads

• Distributed Memory / Message Passing

• Data Parallel

• Hybrid

• Single Program Multiple Data (SPMD)

• Multiple Program Multiple Data (MPMD)

Parallel programming models exist as an abstraction above hardware and memory 
architectures.
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• The very fast development in parallel processing and related areas has blurred

conceptual bound-aries, causing a lot of terminological confusion.

• Even well-defined distinctions such as shared memory and distributed memory

are merging due to new advances in technology.

• There are no strict delimiters for contributors to the area of parallel processing.

Hence, computer architects, OS designers, language designers, and computer

network designers all have a role to play.



UNIT- IV

- Virtualization: Introduction

- Characteristics of virtualized environments

- Taxonomy of virtualization techniques - Virtualization and cloud computing

- Pros and cons of virtualization

- Technology example: VMware: full virtualization

- Types of hardware virtualization: Full virtualization - partial virtualization -

para virtualization.
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Definition

• Virtualization is the ability to run multiple operating
systems on a single physical system and share the
underlying hardware resources*

• It is the process by which one computer hosts the 
appearance of many computers.

• Virtualization is used to improve IT throughput and
costs by using physical resources as a pool from which
virtual resources can be allocated.

*VMWare white paper, Virtualization Overview



Virtualization Architecture
•A Virtual machine (VM) is an isolated runtime

environment (guest OS and applications)

•Multiple virtual systems (VMs) can run on a single

physical system



Hypervisor

• A hypervisor, a.k.a. a virtual machine
manager/monitor (VMM), or virtualization manager,
is a program that allows multiple operating systems to
share a single hardware host.

• Each guest operating system appears to have the
host's processor, memory, and other resources all to
itself. However, the hypervisor is actually controlling
the host processor and resources, allocating what is
needed to each operating system in turn and making
sure that the guest operating systems (called virtual
machines) cannot disrupt each other.



Benefits of Virtualization

• Sharing of resources helps cost reduction

• Isolation: Virtual machines are isolated from each 
other as if they are physically separated

• Encapsulation: Virtual machines encapsulate a 
complete computing environment

• Hardware Independence: Virtual machines run 
independently of underlying hardware

• Portability: Virtual machines can be migrated 
between different hosts. 



Virtualization in Cloud Computing

Cloud computing takes virtualization one step further:

• You don’t need to own the hardware
• Resources are rented as needed from a cloud

• Various providers allow creating virtual servers:

• Choose the OS and software each instance will have

• The chosen OS will run on a large server farm

• Can instantiate more virtual servers or shut down existing 
ones within minutes

• You get billed only for what you used



Characteristics Of Virtualized Environments

• Increased security

The ability to control the execution of a guest in a completely transparent manner opens new pos-

sibilities for delivering a secure, controlled execution environment. The virtual machine repre-

sents an emulated environment in which the guest is executed. All the operations of the guest are

generally performed against the virtual machine, which then translates and applies them to the

host. This level of indirection allows the virtual machine manager to control and filter the activity

of the guest, thus preventing some harmful operations from being performed. Resources exposed

by the host can then be hidden or simply protected from the guest.
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• Managed execution

Virtualization of the execution environment not only allows increased security, but a wider range of features

also can be implemented. In particular, sharing, aggregation, emulation, and isolation are the most relevant

features.

• Portability
 The concept of portability applies in different ways according to the specific type of virtualization

considered. In the case of a hardware virtualization solution, the guest is packaged into a virtual image

that, in most cases, can be safely moved and executed on top of different virtual machines. Except for the

file size, this happens with the same simplicity with which we can display a picture image in differ-ent

computers.

 In the case of programming-level virtualization, as implemented by the JVM or the .NET runtime, the

binary code representing application components (jars or assemblies) can be run without any

recompilation on any implementation of the corresponding virtual machine.
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Virtualization And Cloud Computing

• Virtualization plays an important role in cloud computing since it allows for the appropriate degree of

customization, security, isolation, and manageability that are fundamental for delivering IT services on

demand. Virtualization technologies are primarily used to offer configurable computing environments and

storage.

• Particularly important is the role of virtual computing environment and execution virtualization

techniques. Among these, hardware and programming language virtualization are the techniques

adopted in cloud computing systems.

• Hardware virtualization is an enabling factor for solutions in the Infrastructure-as-a-Service (IaaS) market

segment, while programming language virtualization is a technology leveraged in Platform-as-a-Service

(PaaS) offerings.

• In both cases, the capability of offering a customizable and sandboxed environment constituted an

attractive business opportunity for companies featuring a large computing infrastructure that was able to

sustain and process huge workloads. Moreover, virtualization also allows isolation and a finer control,

thus simplifying the leasing of services and their accountability on the vendor side.
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Advantages of Virtualization

• Managed execution and isolation

• Portability

• Efficient use of resources

Disadvantages of Virtualization

• Performance degradation

• Inefficiency and degraded user experience

• Security holes and new threats
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Technology Example

VMware: full virtualization

VMware’s technology is based on the concept of full virtualization, where the underlying hardware is

replicated and made available to the guest operating system, which runs unaware of such abstraction layers

and does not need to be modified. VMware implements full virtualization either in the desktop

environment, by means of Type II hypervisors, or in the server environment, by means of Type I hypervisors.

In both cases, full virtualization is made possible by means of direct execution (for nonsensitive instructions)

and binary translation (for sensitive instructions), thus allowing the virtualization of architecture such as

x86.

Besides these two core solutions, VMware provides additional tools and software that simplify the use of

virtualization technology either in a desktop environment, with tools enhancing the integration of virtual

guests with the host, or in a server environment, with solutions for building and managing virtual computing

infrastructures.
12



Hardware Virtualization Techniques

• Full Virtualization

 Full virtualization refers to the ability to run a program, most likely an operating system, directly on top of a

virtual machine and without any modification, as though it were run on the raw hardware.

 The principal advantage of full virtualization is complete isolation, which leads to enhanced security, ease of

emulation of different architectures, and coexistence of different systems on the same platform.

 A key challenge is the interception of privileged instructions such as I/O instructions: Since they change the

state of the resources exposed by the host, they have to be contained within the virtual machine manager.

 A simple solution to achieve full virtualization is to provide a virtual environment for all the instructions, thus

posing some limits on performance. A successful and efficient implementation of full virtualization is obtained

with a combination of hardware and software, not allowing potentially harmful instructions to be executed

directly on the host.
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• Partial Virtualization

 Partial virtualization provides a partial emulation of the underlying hardware, thus not allowing the

complete execution of the guest operating system in complete isolation.

 Partial virtualization allows many applications to run transparently, but not all the features of the

operating system can be supported, as happens with full virtualization.

 An example of partial virtualization is address space virtualization used in time-sharing systems; this

allows multiple applications and users to run concurrently in a separate memory space, but they still

share the same hardware resources (disk, processor, and network).

 Historically, partial virtualization has been an important milestone for achieving full virtualization, and it

was implemented on the experimental IBM M44/44X. Address space virtualization is a common feature

of contemporary operating systems.
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• Paravirtualization

 This is a not-transparent virtualization solution that allows implementing thin virtual machine managers.

 Paravirtualization techniques expose a software interface to the virtual machine that is slightly modified

from the host and, as a consequence, guests need to be modified.

 The aim of paravirtualization is to provide the capability to demand the execution of performance-critical

operations directly on the host, thus preventing performance losses that would otherwise be experienced

in managed execution.

15



 

UNIT-I 

 

Cloud Computing Overview –Services of Internet, Origins of Cloud computing – Cloud 

components – Essential characteristics – On-demand self-service, The vision of cloud 

computing – Characteristics, benefits, and Challenges ahead. 

 

 

 



 

Why Cloud? 

• Cloud provides a host of benefits which make it so popular. 

• We can not only store large amounts of data securely on the cloud, but it is also possible to 

rent the latest hi-tech software and even hardware. 

• For example:  

• Consider that you are using a traditional method of computing in your office, now if your 

company recruits some more employees then you need to do all the hardware as well as 

software setup for all those employees again which will inevitably increase your expenses.  

• However, using cloud computing you get the platform on rent and simply provide the 

employees a terminal and credentials to logon to their virtual system. Hence, in this case you 

rent the processing time, memory and the software setup.  

• Whenever an employee quits, his resources are freed and there is no need to pay for those 

rentals. 

 



 

Why Cloud? 

The cloud itself is a set of hardware, networks, storage, 

services and interfaces that enable the delivery of computing 

as a service. 

Cloud Computing – Definition: 

Cloud Computing is the on-demand delivery of computer 

power, infrastructure, applications, storage and other IT 

resources through a cloud services platform via the internet 

with pay-as-you-go pricing. 



 

History of Cloud Computing 
 



 

 

History of Cloud Computing 

• The origin of cloud can be traced as far back as 1950s 

when John McCarthy, a computer scientist, introduced 

‘theory of time sharing’. 

• In the 1960s, J.C.R. Licklider developed the ARPANET 

(Advanced Research Projects Agency Network) which 

formed the basis of today’s internet. 

• The development of virtual machines in 1970s enabled 

users to run multiple operating systems on a single 

machine. 

• In 1991, the World Wide Web emerged. 



 

History of Cloud Computing 

• The 1990s also saw a shift from point-to-point data 

circuits to virtual private network services being offered 

by telecommunication companies. This resulted in 

increased bandwidth at a lower cost. 

• In 1997, the first definition of cloud computing was given 

by Professor Ramnath Chellapa of Emory University. He 

defined Cloud Computing as, 

‘Computing paradigm where the boundaries of 
computing will be determined by economic rationale 

rather than technical limits alone.’ 
 

 

 



 

Major Milestones: 

• 1999: Salesforce.com 

 Established the ability to use a simple website on the Internet to deliver enterprise-level 

applications. 

• 2002: Amazon Web Services 

 Featured several cloud-based retail services which 

included data storage and computation. 

• 2006: Amazon’s Elastic Compute Cloud (EC2) – the first 

commercial cloud 

 Enabled small companies to rent computers that would host and run their own 

applications. 

• 2007: Dropbox 

 MIT student created this file-hosting service that offers file storage and synchronization. 



 

• 2009: 

 Google Apps – example of browser-based enterprise 

applications 

 Windows Azure – Microsoft’s cloud computing platform 



 

Characteristics of Cloud Computing 

1. On-demand Service 

2. Broad Network Service 

3. Resource Pooling 

4. Rapid Elasticity 

5. Measured Service 

 

 

 

 

 



 

Characteristics of Cloud Computing 

1. On-demand Service: The user can provide the required resources automatically without 

human intervention. 

2. Broad Network Access: Accessible from any of the consumer’s devices (such as Mobile, 
tablet, laptop and Desktop). 

3. Resource Pooling: Multiple consumers can use multiple physical and virtual resources 

dynamically assigned and reassigned according to their demand. 

4. Rapid Elasticity: Capabilities can be provisioned elastically. They can be scaled up and down 

based on the consumer’s demand. 

5. Measured Service: The service is measured using the pay-as-you-go pricing model. 

 

 



 

Types of Cloud Services: 

The major three categories are IaaS, PaaS and SaaS. 

1. Infrastructure as a service (IaaS): The cloud provider provides IT infrastructure like the servers, 

virtual machines, storage, networks, and the operating systems on pay-as-you-go basis. 

2. Platform as a service (PaaS): The developers may use the cloud computing services on demand for 

creating a web or mobile application. They need not worry about setting up the development 

environment. 

3. Software as a service (SaaS): The users just connect to the Internet through phone, PC or the tablet 

and use the application hosted on cloud. The cloud service providers host and manage the software 

application, infrastructure, handle maintenance and upgrades including patching. 

 

 

 



 

The Three Major Cloud Services: 

 

 



 

Types of Cloud Services: 

Other Cloud services: 

1. Data as a service (DaaS): data are stored on cloud and made available to users on demand 

regardless of their geographic location. 

2. Desktop as a service provides a virtual desktop. 

3. Storage as a service (SaaS) provides data storage infrastructure. 

4. Test environment as a service: we can rent a test setup to quickly test our application. 

5. Security as a service (SECaaS): we can allow the cloud provider to take care of the 

security. 

6. API as a service is a SaaS exposed as an API (Application Programming Interface). It allows 

users to access web services such as Google Maps, credit card processing and payroll 

processing. 

 

 



 

Benefits of Cloud Computing 

 Scalability: To accommodate variable workloads, cloud infrastructure scales on demand. 

 Storage Options: Users may select between public, private, or hybrid storage choices, based on their security 

needs and other factors. 

 Control Options: As-a-service options allow organizations to choose their amount of control. 

 Security Structure: Virtual private cloud, encryption, and API keys are all security elements that assist keep 

data safe. 

 Data security: In the case of hardware failure, networked backups avoid data loss. 

 Savings on Equipment: Cloud computing makes use of distant resources, which saves businesses money on 

servers and other hardware. 

 Payments: Users only pay for the resources they utilize when they employ a “utility” pay structure. 
 Regular Updates: Service providers update their products regularly to ensure that consumers have access to 

the most up-to-date technologies. 

 Collaboration: Because of global access, teams may cooperate from all over the world. 

 Competitive Advantage: Businesses can move more quickly than competitors who must spend IT resources 

on infrastructure management. 



 

Challenges 

 Privacy and Security: The fundamental problem with cloud computing is security and privacy. Security apps, 

encrypted file systems, and data loss tools can all help to mitigate these issues. 

 Interoperability: One platform’s application should be able to use services from the other platform. 
Interoperability is the term for this. Web services are making this possible but developing such web services is 

difficult. 

 Portability: Applications operating on one cloud platform may be migrated to a different cloud platform and 

should continue to work without any design or code modifications. Because each cloud provider employs a distinct 

standard language for their platform, portability is not achievable. 

 Quality of Service: The providers’ Service-Level Agreements (SLAs) are insufficient to ensure availability and 

scalability. Businesses are hesitant to move to the cloud unless there is a solid service quality assurance. 

 Computing Performance: For data-intensive cloud applications, high network bandwidth is required, which 

results in a high cost. Low bandwidth does not match the computational performance requirements of cloud 

computing. 

 Availability and Dependability: Because the majority of organizations rely on third-party services, cloud 

solutions must be dependable and stable. 

 


